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1 Introduction

In this chapter, you can find information about the intended use, the addressed
target group, and information about safety and privacy related topics.

Please adhere to the ETAS Safety Advice (Help > Safety Advice) and to the
safety information given in the user documentation.

ETAS GmbH cannot be made liable for damage which is caused by incorrect use
and not adhering to the safety messages.

1.1 Demands on Technical State of the Product
The following special requirements are made to ensure safe operation:

Take all information on environmental conditions into consideration before
setup and operation (see the documentation of your computer, hardware,
etc.).

1.2 Intended Use
The ETAS ASCMO tool family is intended for offline data based modeling, model
based calibration or efficient optimization of parameters in physics based mod-
els. It is not intended to operate directly in a running system.

With ASCMO-STATIC and ASCMO-DYNAMIC it is possible to accurately model the
behavior of complex systems on the basis of a small set of measurement data.
This model can either be used to analyze and optimize input parameters or as a
black box plant model in other simulation environments. In contrast to this
ASCMO-MOCA typically uses existing physics based models with a defined struc-
ture to calibrate and optimize the parameters of the model itself. The results are
a suggestion and must be additionally validated before further processing.

ETAS GmbH cannot be made liable for damage which is caused by incorrect use
and not adhering to the safety information. See Help > Safety Advice

1.3 Target Group
This manual is directed at trained qualified personnel in the development and cal-
ibration sector of motor vehicle ECUs. Technical knowledge in measuring and con-
trol unit engineering is a prerequisite. 

1.4 Classification of Safety Messages
Safety messages warn of dangers that can lead to personal injury or damage to
property:

DANGER

DANGER indicates a hazardous situation that, if not avoided, will result in death
or serious injury.
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WARNING

WARNING indicates a hazardous situation that, if not avoided, could result in
death or serious injury.

CAUTION

CAUTION indicates a hazardous situation that, if not avoided, could result in
minor or moderate injury.

NOTICE
NOTICE indicates a situation that, if not avoided, could result in damage to
property.

1.5 Safety Information

NOTICE
Damage due to wrong calibration data

Wrong usage of calibrations derived from ASCMO-MOCA model can lead to
engine or test bench damage.

Compare measured data and model created data with Residual Analysis fea-
ture after the optimization or before exporting at the latest. Feature is access-
ible via Analysis > Residual Analysis > Training and Test Data > Absolute Error
Analysis.

See "Performing the optimization" on page 117, export options in "Parameters"
Step or "Optimization" Step, and 6.9 "Step 7: Export" on page 118.

NOTICE
Potential malicious code from external source

For FMU, ASCET and TSiM model types, ASCMO-MOCA executes an external
runnable during model evaluation.

Make sure that the external runnable of the model comes from a trustworthy
source.
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1.6 Data Protection
If the product contains functions that process personal data, legal requirements
of data protection and data privacy laws shall be complied with by the customer.
As the data controller, the customer usually designs subsequent processing.
Therefore, he must check if the protective measures are sufficient.

1.7 Data and Information Security
To securely handle data in the context of this product, see the next sections
about data and storage locations as well as technical and organizational meas-
ures.

1.7.1 Data and Storage Locations
The following sections give information about data and their respective storage
locations for various use cases.

1.7.1.1 License Management
When using the ETAS License Manager in combination with user-based licenses
that are managed on the FNP license server within the customer's network, the
following data are stored for license management purposes:

Data

Communication data: IP address

User data: Windows user ID

Storage location

FNP license server log files on the customer network

When using the ETAS License Manager in combination with host-based licenses
that are provided as FNE machine-based licenses, the following data are stored
for license management purposes:

Data

Activation data: Activation ID
l Used only for license activation, but not continuously during license

usage

Storage location

FNE trusted storage
C:\ProgramData\ETAS\FlexNet\fne\license\ts

1.7.2 Technical and Organizational Measures
We recommend that your IT department takes appropriate technical and organ-
izational measures, such as classic theft protection and access protection to
hardware and software.
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2 About ASCMO-MOCA

ASCMO-MOCA is a tool forModeling andCalibration of functions with given data.
These functions consist of mathematical operations on changeable parameters
like lookup tables. The goal is to minimize the deviation of the output of the func-
tion to given data. The parameters of the function are adapted (calibrated) with
an optimizer to minimize this deviation. Additional constraints like smoothness
and gradients of curves/maps can be considered.

The results can be visualized in different views like scopes and scatter plots. A
residuals analysis allows to detect problems, e.g. outliers.

ASCMO-MOCA comes in two versions, the full version and the runtime version.
The full version allows modeling of the function, definition of an optimization
sequence and the optimization itself. The runtime version opens existing pro-
jects from the full version and allows to import data and allows to start of the
optimization, but not the definition of the function or the optimization sequence.

Building blocks of the function in ASCMO-MOCA are scalars, lookup tables, RBF
(Radial Basis Function)-Nets and models from other sources like Simulink.

A time-independent function without inner states and loops can directly be
modeled in ASCMO-MOCA. More complex, time-dependent functions are to be
modeled in other tools like Simulink®. ASCMO-MOCA then uses the external tool
during the optimization.

2.1 Finding Out More
Besides this User Guide, the online help is recommended – particularly when work-
ing with the user interface. It can be called up via Help > Online Help or context-
sensitive (with <F1>) in the respective open operating window.

Help about the functions of the P-code version can be obtained via Help > Inter-
face Help.
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3 Installation

This chapter provides information for preparing and performing the installation
and for licensing ASCMO-MOCA V5.13.

3.1 "Preparation" below

3.2 "Installing" below

3.3 "Licensing" on page 15

3.1 Preparation
Prior to the installation, check that your computer meets the system require-
ments (see Release Notes "System Prerequisites"). Depending on the operating
system used and network connection, you must ensure that you have the
required user rights.

Note

Ensure that you have the necessary access privileges to the Windows registry
database for the installation and operation of the software. If in doubt, contact
your system administrator.

3.1.1 User Privileges
Please observe the following notes concerning the user privileges for the install-
ation and operation.

Required User Privileges for the Installation
To install the software on the PC, you require the user privileges of an admin-
istrator. If necessary, contact your system administrator.

Required User Privileges for the Operation
To operate the software, privileges of a standard user are sufficient.

3.1.2 Additional Software Requirements
All required software components that may be missing are installed during the
installation of ASCMO-MOCA V5.13 and ASCMO-MOCA Runtime V5.13.

3.2 Installing
Starting the installation

1. Go to the directory where the installation file is located and double-click on
the Setup_ASCMO_x64.exe file.

The Setup Wizard opens.
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2. Click Next.

The "License Agreement" window opens.

3. Read the license agreement carefully, then activate I accept the agree-
ment.

4. Click Next.

The "Set Destination Location" window opens.

If you have already installed ETAS ASCMO, the path (Destination Location
and Start Menu Folder) of the initial installation is used.

5. Accept the default folder or click Browse to select a new folder.
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6. Click Next.

The "Select Start Menu Folder" window opens.

7. Accept the default directory or click Browse to select a new directory.

8. Click Next.

The "Selected Additional Tasks" window opens.

9. Activate theCreate a desktop icon checkbox if you want to create an
icon on the desktop.

10. Activate one of the options regarding MATLAB Compiler Runtime install-
ation.

11. If necessary, activate Install Prerequisites.

12. Click Next.

The "Ready to Install" window opens. You can check the information you
entered in the previous windows.
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13. If you want to change settings, click Back.

14. Click Install if you want to start the installation.

The installation is performed. A progress indicator shows how the install-
ation is progressing.

When the installation is complete, the "Completing the ASCMO-MOCA
Setup Wizard" window opens.

15. Click Finish.

The installation is completed. ETAS ASCMO can be started.

3.2.1 Start Menu
After successful installation, the folder you specified in the "Select Start Menu
Folder" window (see page 12) with the following entries is added to the Windows
start menu.

ASCMO Desk V5.13

Starts the ASCMO-DESK window, where you can start your ETAS ASCMO
components.

ASCMO Dynamic V5.13

Starts ASCMO-DYNAMIC.

ASCMO ExpeDes Dynamic V5.13

Starts ASCMO-DYNAMIC ExpeDes.

ASCMO ExpeDes V5.13

Starts ASCMO-STATIC ExpeDes.

ASCMO MOCA Runtime V5.13

Starts the ASCMO-MOCA Runtime environment with limited functionality.
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ASCMO MOCA V5.13

Starts ASCMO-MOCA.

ASCMO Static V5.13

Starts ASCMO-STATIC.

Manuals and Tutorials

Opens the ASCMO documentation directory
(<installation>\Manuals), which contains the following information
and documents.
l ASCMOInterfaceDoc – a folder with interface documentation
l Examples – a folder with different example data (e.g. ASCMO projects,

MF4, DCM, XLS or FMU files, templates, plugins, etc.)
l HTML folder – online help files for the installed components (available

via <F1>)
l Manual_dynamic_en.pdf and Manual_dynamic_jp.pdf – User

Guide with tutorials for the basic functions of ASCMO-DYNAMIC
l Manual_en.pdf and Manual_jp.pdf – User Guide with tutorials for

the basic functions of ASCMO-STATIC
l MOCA_*.pdf – User Guide with a tutorial for the basic functions of

ASCMO-MOCA

3.2.2 Files and Directories
All files belonging to the program are located in the <installation> directory
selected during the installation, and in additional subfolders of this directory.

By default, <installation> is C:\Program Files\ETAS\ASCMO

[[[Undefined variable ASCMOVar.prod_version2]]].

Of special interest are the P-code files for MATLAB® and Simulink® in the
<installation>\pCode\ascmo directory.

For more details, refer to section P-Code Version.

3.2.3 P-Code Version
The P-code version (see 3.2.2 "Files and Directories" above) also allows to start
ETAS ASCMO within MATLAB®.

Prerequisites
The P-code version requires an installation of MATLAB® R2016a up to R2019b. In
addition, the following MATLAB® toolboxes are required:

Optimization Toolbox™

Statistics and Machine Learning Toolbox ™
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Executing ETAS ASCMO
In MATLAB®, change to the directory <installation>\pCode\ascmo. In the
command window, enter one of the following commands:

command action

AscmoDesk Starts ASCMO-DESK.

ascmo static Starts ASCMO-STATIC.

ascmo expedes Starts ASCMO-STATIC ExpeDes.

ascmo dynamic Starts ASCMO-DYNAMIC.

ascmo expedesdynamic Starts ASCMO-DYNAMIC ExpeDes.

ascmo moca Starts ASCMO-MOCA.

ascmo mocaruntime Starts ASCMO-MOCA Runtime.

ascmo cyclegenerator Starts the standalone ASCMO-Cycle Gen-
erator.

ascmo scatterplot Starts the standalone ASCMO-Scatter Plot.

ascmo cal-

ibrationdataeditor
Starts the standalone ASCMO-Calibration
Data Editor.

All further steps in an ETAS ASCMO tool – except the ASCMO-Scatter Plot and
ASCMO-Calibration Data Editor – can be automated using commands whose
description can be found in the main menu under Help > Interface Help.

3.3 Licensing
A valid license is required to use the software. You can obtain a license in one of
the following ways:

from your tool coordinator

via the self-service portal on the ETAS website at www.etas.-
com/support/licensing

via the ETAS License Manager

To activate the license, you must enter the Activation ID that you received from
ETAS during the ordering process.

For more information about ETAS license management, see the ETAS License
Management FAQ or the ETAS License Manager help.

To open the ETAS License Manager help

The ETAS License Manager is available on your computer after the installation of
any ETAS software.
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1. From the Windows Start menu, select E > ETAS > ETAS License Manager.

The ETAS License Manager opens.

2. Click in the ETAS License Manager window and press F1.

The ETAS License Manager help opens.

3.4 Uninstalling

Note

You cannot uninstall specific components. The procedure uninstalls all ETAS
ASCMO components.

Use Programs and Features from the Windows control panel to start the ETAS
ASCMO uninstall process.

To uninstall ETAS ASCMO

1. Start the uninstall procedure.

A warning message opens.

2. Click Yes to continue.

3. ClickOK to end the uninstallation.
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4 Basics of ASCMO-MOCA

ASCMO-MOCA enables optimization of model parameters and minimizes the devi-
ation of model prediction and desired output values.

E.g. modern vehicle ECUs contain physics based models to replace or monitor
real sensors. Such a physics based model is generic, but must be adapted to an
actual engine. Parameters (maps/curves/scalars) are optimized using real meas-
urements, e.g., from test bench or vehicle.

The model can be represented in ASCMO-MOCA as a set of formulas entered by
the user. Alternatively, existing models, e.g. from Simulink®, can be used.

In this chapter, you can find a description of the basic concepts of ASCMO-
MOCA.

These are the following:

"Fields of Application of ASCMO-MOCA" on the next page

This section provides a general overview of the wide range of application
fields in ASCMO-MOCA.

"Elements of the ASCMO-MOCA User Interface " on page 73

This section provides an brief overview of the user interface key elements
of ASCMO-MOCA.

"Data" on page 19

This section provides information on import, analysis and preprocessing of
measured data.

"Assessment of the Input Data" on page 19

In this section you will find information on how you can assess the quality
of the input data used by ASCMO-MOCA for the parameter optimization.

"Models" on page 36

This section provides information on importing and using external models
in ASCMO-MOCA.

"Function" on page 39

This section provides information on how to create a model by specifying a
set of formulas that form a function.

"Parameters " on page 26

This section contains general information about the optimization of para-
meters within ASCMO-MOCA.

"Available Types of Parameters" on page 26

This section provides a brief overview of the various types of parameters
that can be used in the function (see "Step 5: Build Up the Function" on
page 109) for optimization (see "Step 6: Optimization" on page 116).
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"Optimization" on page 46

This section contains a description of the different optimization methods
and the optimization criteria that can be used for the parameter optim-
ization.

4.1 Fields of Application of ASCMO-MOCA
This section provides a general overview of the wide range of application fields of
ASCMO-MOCA.

4.1.1 Calibration of ECU Sensor Data
Optimization of parameters

Optimization of time-dependent (dynamic) functions

Parameterization of ECU models (cylinder fill, torque, ...)

The use of ASCMO-MOCA in the area of calibration offers a series of advantages:

Significant increase in efficiency through reduced measuring and analysis
efforts

Improved complexity handling

Improved data quality

Multiple use of models

4.1.2 Research, Function and System Development
Quick calibration and evaluation of experimental engines

Use of models of real engines for test and development of new functions
(e.g., controller strategies)

Analysis and optimization of unknown systems.

The advantages in the area of research and development lie primarily in a quicker
and more improved system understanding, coupled with a variety of possibilities
for impact analysis.

4.1.3 Fields of Application of ASCMO-MOCA Runtime
The Runtime version of ASCMO-MOCA is designed to fulfill the special require-
ments of using the software with limited access to special functionalities.
Reasons for doing this are to hide away special IP or to avoid that an user
changes something critical.

This version can be either installed and used in parallel to the main (Developer)
version or as standalone.

Note

The Runtime version does not allow to create or modify functions.

The following activities can be carried out with ASCMO-MOCA Runtime:
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Import of stationary or transient data followed by name-mapping.

Definition of conversion rules (Conversion Parameters / formulas).

Import, export, creation, deletion and editing of parameters and system
constants.

Iterative optimization and calibration of parameters.

The installation of ASCMO-MOCA Runtime is particularly recommended if the one
who has created the project with the optimization task is not the same as the
one who executes the optimization.

This supports intellectual property protection and safety:

You do not have to share special know-how about the function or the
optimization logic with others.

No critical parameters and settings are changed by the user who performs
the optimization. Such changes could result in unexpected behavior.

4.2 Data
The first steps in ASCMO-MOCA are import, analysis and preprocessing of meas-
ured data. These steps are performed in the Data Step.

For more information, see the following subsections and the online help.

"Assessment of the Input Data" below

"Step 1: Data Import" on page 81 (tutorial)

4.2.1 Assessment of the Input Data
This section provides information on how you can assess the quality of the input
data used by ASCMO-MOCA for the parameter optimization.

"Tabular Representation of All Model-Related Data" below

"Checking the Relevance of the Inputs" on the next page

"Function Assessment and Improvement" on the next page
l "Graphical Analysis of Data and Function Nodes" on the next page
l "Residual Analysis" on page 21
l "Improving the Model Quality" on page 24

"Variables RMSE and R2" on page 24

"Function Evaluation Using RMSE and R2" on page 25

4.2.1.1 Tabular Representation of All Model-Related Data
The Analysis > Data Table > Training Data/Test Data/Training and Test Data
menu options open a table that displays the imported data columns, converted
data columns from conversion formulas and additionally calculated nodes from
the function. If optimization criteria are defined, also the residuals are displayed.

Note

The data in the "All Data" window cannot be modified.
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The following values are shown in the table in detail:

imported data

converted data (conversion rules)

nodes (from functions)

residuals (from optimization criteria)

Fig. 4-1: The "All Data" window

4.2.1.2 Checking the Relevance of the Inputs
During data import, you can check the inputs' relevance to the outputs (see also
"To check the relevance of the inputs" on page 84).

If you do so, a polynomial stepwise regression is done with the inputs and out-
puts. The stepwise regression ignores inputs with a significance < 5% and can
find dependent inputs.

If, for example, the training data contains the inputs speed, load and speed +
load, then one of the inputs has a low significance.

The order of the inputs is important. After the stepwise regression, the inputs are
permuted column by column, and a pseudo RMSE is calculated per input, to get a
heuristic of the input's relevance. The findings are then plotted in the "Relevance
of Inputs" window.

4.2.1.3 Function Assessment and Improvement
The Analysismenu offers a number of functions to compare the model output
prediction with the measured data of the function output. Specifically, these are:

Graphical analysis of the measured data and the function nodes

See "Graphical Analysis of Data and Function Nodes" below for details.

Residual analysis

See "Residual Analysis" on the next page for details.

Graphical Analysis of Data and Function Nodes
The scatter plots (AnalysisMenu) in the following windows provide a graphical
control of the measurement data and the function evaluation:
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"Data - Training Data/Test Data/Training and Test Data"

"FunctionNode - Training Data/Test Data/Training and Test Data"

"Data and Nodes - Training Data/Test Data/Training and Test Data"

When analyzing the measurement data, the following points should be con-
sidered particularly:

Have all data been varied in accordance to the Design of Experiment (DoE)
and has the measured system remained in the intended operating mode?

Are the output values in a physically reasonable range?

Are there outliers included which must be removed if appropriate?

Fig. 4-2: The "Data and Nodes" window

Residual Analysis
Residuals are the deviation of the data calculated according to the optimization
criteria to the measured data.

Three types of residual analysis are available:

Absolute Error Analysis

For the Absolute Error Analysis, all residuals are displayed:
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Relative Error Analysis

For the Relative Error Analysis the quotient from the residue and the meas-
ured value is displayed:

Therefore, a percentage deviation is displayed.

Studentized Error Analysis

When performing a Studentized error analysis, the quotient from the resid-
ual and the RMSE 4.2.2.1 "RMSE (Root Mean Squared Error)" on page 24 is
displayed:

Thus, the error based on the RMSE is shown.

Residual analysis is performed via the Analysis > Residual Analysis > *menu
options. These menu options open four plot windows:

"Histogram" Window
The "Histogram" window displays the current error distribution (blue bars) on the
total number of values for the predicted function output. The normal distribution
fit (red line) is drawn additionally. This function enables you to validate whether
the current error distribution fits to the normal distribution or not.

Fig. 4-3: The "Histogram" window

"Residuals over Inputs" Window
This window shows several scatter plots: data set number, Active flag and weight
against measurement number, as well as the errors (absolute, relative, or stu-
dentized) of the computed data against the measured data. For a detailed
description, see "Improving the Model Quality" on page 24.
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Fig. 4-4: The "Residuals over Inputs" window

"Residuals over Outputs" Window
This window shows scatter plots of the errors (absolute, relative, or studentized)
of the computed data against the function nodes.

"Measured vs. Predicted" Window
In this window, the model output is displayed on the X axis and the measuring
points are displayed on the Y axis. A perfect match between the two would result
in a "pearl necklace" (y = x). The further the points are removed from the y = x

line, the greater the difference between measurement and model output.
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Fig. 4-5: The "Measured vs. Predicted" window

The "Residuals over *" and "Measured vs. Predicted" windows are described in
detail in the online help.

Improving the Model Quality
Outliers can be caused by measurement errors or by insufficient function quality.
The scatter plots mentioned in sections "Graphical Analysis of Data and Function
Nodes" on page 20 and "Residual Analysis" on page 21 allow visually determining
and improving the model quality. You can search for outliers, draw a rectangle to
mark them, delete them, deactivate them or reduce their weight manually, or you
can set an outlier threshold and detect outliers automatically.

4.2.2 Variables RMSE and R2

A series of variables is used for quantifying the function quality. These variables
are described in this section.

4.2.2.1 RMSE (Root Mean Squared Error)
The RMSE describes the variance to be expected (standard deviation) about the
model: A second measurement falls less than 1 RMSE from the model prediction
with a probability of 68% (with 95.5% < 2 RMSE, 99.7% < 3 RMSE, etc.).

The RMSE is defined as follows:

Equ. 4-1: Root Mean Squared Error (RMSE)

whereby N = the number of measuring data and

Equ. 4-2: Sum of Squared Residuals (SSR)

Therefore, SSR is the sum of squared residuals (SSR = Sum of Squared Resid-
uals).

4.2.2.2 Coefficient of Determination R2

The coefficient of determination R2 is derived from the comparison of the vari-
ance that remains after the model training (SSR) with the variance concerning
the mean value of all measuring data (SST)

Equ. 4-3: Coefficient of determination R2 whereby
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Equ. 4-4: Total Sum of Squares (SST)

R2 is a relative measure for evaluating the function output error – it indicates
which portion of the total variance of the measuring data is described by the func-
tion.

4.2.3 Function Evaluation Using RMSE and R2

Evaluation of R2

The most important variable is the coefficient of determination R2 ("Coefficient of
Determination R2" on the previous page) . This measure results in the following
evaluations:

The coefficient of determination, R2, can be maximal 1. In this case, the
function prediction fits exactly to each measured value.

If the function would simply predict the mean of the measured output for
any input data, an R2 of 0 would be the result. A negative R2 would mean
that the prediction is worse than that simple prediction.

An R2 of 1 means a perfect fit, every prediction of the function is the same
as the measured data. Typically, the measured data has added noise. In
this case, an R2 of 1 means overfitting. You should be interested in a high R2

with consideration of the noise.

Keep in mind that different signals can be measured with different quality.
There might be signals where an R2 of 0.6 might already be a good value. In
contrast, a model for a different signal can be seen as good only if the R2 is
above 0.99.

Evaluation of RMSE
The absolute error RMSE (see section "RMSE (Root Mean Squared Error)" on the
previous page) must be evaluated individually:

At best, the RMSE can be as good as the experimental repeatability.

Despite a good R2, the RMSE can be too low, e. g. in case of a very large vari-
ation range of the modeled variable.

Despite a small R2, the RMSE can be good enough, e. g. if the modeled vari-
able features only a minor variance over the input parameters of the func-
tion.
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4.3 Parameters
Modern ECUs contain many map-based physical models1) to replace or monitor
real sensors, e. g.:

Engine torque

Air charge/Air mass

Exhaust gas temperature

Fuel system corrections

To provide an optimal prediction quality, these models contain parameters such
as maps (see also "Maps" on the next page) and curves (see also "Curves" on
page 28) that need to be calibrated using real measurement data (e. g., from test
bench or vehicle).

The high number of actuators in modern engines leads to a continuous increase
in the complexity and the number of parameters of these functions.

A manual calibration is either very time consuming or even impossible.

ASCMO-MOCA supports the calibration and optimization tasks in an efficient and
user-friendly way.

4.3.1 Example
You can find an example of parameter optimization for a sensor in the chapter
"Tutorial: Working with ASCMO-MOCA" on page 78. In this tutorial, different maps
and curves will be optimized in order to reduce the deviation between the meas-
ured values and the model prediction.

4.3.2 Available Types of Parameters
This chapter provides a brief overview of the various types of parameters that
can be used in the function (see "Step 5: Build Up the Function" on page 109) for
optimization (see "Step 6: Optimization" on page 116).

The parameters are divided in to the following classes:

"Maps" on the next page

"Curves" on page 28

"Scalar" on page 29

"3D- and 4D-Cubes" on page 29

"Compressed Model" on page 29

"Matrix " on page 29

"Group Axis" on page 30

" Text Scalar/Matrix/Curve/Group Axis" on page 30

Scalar, Cube-3D and Cube-4D parameters are similar to curves and maps, except
that they have no, three (X, Y, Z1), or four (X, Y, Z1, Z2) axes. See the online help
for an instruction on how to create such a parameter.

1) Similar models are used in other environments such as HiL systems.
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Maps
A map is represented by a set of Z values that are defined over a two-dimensional
grid that represents the X and Y axes.

In between grid points, the corresponding Z values are calculated by bi-linear
interpolation. Therefore, the functional dependency is given by z = z(x, y)

and a map is stored in the form of a two-dimensional lookup table.

Outside the grid, either clip- or linear interpolation is applied.
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You can set up input-dependent bounds for map parameters. These can be
edited in the Parameter <parameter_name>window; see the online help for
more information.

Curves
A curve is represented by a set of Y values that are defined over a one dimen-
sional grid, that represents the X axis.

In between grid points, the corresponding Y values are calculated by linear inter-
polation. Therefore, the functional dependency is given by y = y(x) and a curve
is stored in the form of a one-dimensional lookup table.

Outside the grid, either clip- or linear interpolation is applied (cf. figure below).
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You can set up input-dependent bounds for curve parameters. These can be
edited in the Parameter <parameter_name>window; see the online help for
more information.

Scalar
A scalar is a 0-dimensional calibration parameter.

3D- and 4D-Cubes
In addition to curves (one input) and maps (two inputs), ASCMO-MOCA supports
also lookup tables with three and four inputs: Cube-3D and Cube-4D.

Compressed Model
In addition to lookup tables (Curve, Map, Cube), ASCMO-MOCA also supports net-
works of radial basis functions with a squared exponential kernel (RBF Net-SE) as
a parameter.

The number of inputs for such a parameter can be chosen by the user. Also the
number of basis functions (kernels) must be chosen by the user. A higher num-
ber of inputs and kernels increases the computational complexity of the optim-
ization and evaluation of such a parameter.

The evaluation function for the parameter is a superposition of Gaussian func-
tions. A rough estimate of the computational complexity for the function is "Num-
ber of inputs" multiplied with "Number of basis functions" evaluations of the e-
function.

It can be seen as a black-box data based model and is also available in ASCMO as
"Compressed Model". It can replace a whole function consisting of multiple
lookup tables and connections between them.

A higher number of kernels increases the fidelity of the model, but it can result in
overfitting and should be tested with test data.

Matrix
ASCMO-MOCA supports matrix parameters. A matrix is a two-dimensional,
indexed set of elements. The position of a scalar value within a matrix is determ-
ined by its associated index values (non-negative integer values).

ASCMO-MOCA V5.13 | User Guide



4 Basics of ASCMO-MOCA | 30

Group Axis
ASCMO-MOCA supports group axes for shared axes, which are used by several
parameters, e.g. multiple maps share the same axes. They are handled as a sep-
arate parameter type. Using group axes ensures, they are consistent. Group axes
are especially useful for Simulink® or FMU parameter mappings. For example if
Simulink® multiple variable mappings point to the same variable in a Simulink®
model or calculated parameters point to the same value reference in an FMU
model. Group axes can be exported and imported as DCM or CDFX file and are
automatically detected and created using the scan or validate function in the
Models Step.
Group axes cannot be used in a function. Group axes can be optimized. Using
group axes speeds up the communication with external models.

Text Scalar/Matrix/Curve/Group Axis

Note

Text parameters can only be imported using a DCM and an A2L file; they cannot
be created or edited. To import them, click Import, select the DCM file, and click
Open. Then, click Load A2L File to select the corresponding A2L file.

Text Scalar: For text scalars, you can select the corresponding label in the Enu-
meration column drop-down. This label consists of the text part and its cor-
responding actual value in the control unit.

Text Matrix: Text matrices are similar to text scalars, but they have multiple cells
with drop-downs where you can select the corresponding labels. These labels
consist of the text and their respective actual values in the control unit.

Text Curve: For text curves, the Label column represents the X-axis and con-
tains both the text part and its corresponding actual value in the control unit. In
the Value column, you can find the corresponding Y-values. To edit a value,
double-click the respective cell.

Text Group Axis: This is a group axis for multiple curves, where the X-axis is dis-
played as text in the Label column. The corresponding actual value in the control
unit is shown in the Index column. The# column represents a continuous count.

4.3.3 System Constants
System constants can be used to provide default values for parameters. One or
more parameters of any type can be assigned to a system constant, and a
default value can be provided for each parameter. For non-scalar parameters, the
same constant value is returned for each point.

By activating a system constant, you define that the default values of the
assigned parameters are used.

System constants are created and managed in the "System Constant" tab of the
Parameters Step.

ASCMO-MOCA V5.13 | User Guide



4 Basics of ASCMO-MOCA | 31

See the online help for an instruction how to create a system constant.

4.3.4 Parametersets
Multiple parametersets can be used and managed whereby one set is always
defined as working and reference parameterset. The working parameterset is the
one, which is optimized and used in the Optimization Step.

The different parametersets can have different parameters, parameters with the
same name can have different support vectors.

In addition to working and reference set, the following parametersets are created
while optimization:

Before last optimization (might be empty, but the set is created and the
default Reference Parameterset)

After last optimization

During all the iterations, i. e. parameterset Iteration 1, Iteration 2, ....

Iterations of the optimizer are automatically stored as separate Parametersets.
This allows to analyze the optimization progress and also go back to a previous
set.

4.4 Visualization
In addition to the performed steps from Data to Optimization, ASCMO-MOCA
provides a Visualization Step for having results visually in one place. You can cre-
ate data and parameter visualizations according to your own taste. The Visu-
alization step allows to combine different plot types to create user defined
representations:
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Text to show additional text-based information

Signal Plot to show scatter and scope plots

Signal Plot 3D to show parameters as 3D plots

Parameter Plot to show parameters such as maps and curves
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Parameter Table to show the value tables for each parameter

Parameter Heatmap to show the data coverage of a parameter

Data Table to show selections from other plots, values are highlighted in
the associated color

ASCMO-MOCA V5.13 | User Guide



4 Basics of ASCMO-MOCA | 34

Histogram to show a bar plot where the values are assigned to bins

For all types showing imported or calculated data, one or more datasets can be
selected to be visualized. Beside this also additional settings can be configured
to show only data points, also the lines between the points or a grid in back-
ground.

For the types showing parameters, beside the selection of the parameter itself
additional content can be chosen such as the reference values or bounds. Para-
meter plots cannot only show the current calibration, they can also be used to
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change it. Through this interaction, the Visualization Step acts like an exper-
imental environment. The effect of changed values is directly visualized in all
other plots.

You can define the layout of multiple views. Selections (rectangles and lassoes)
can be used in signalplots and highlight the data in any view. Cursors can show
the value at a specific time. Cursors can be set as a limit to show the number of
values outside the limit. Selections and cursors are saved with the project.

For each visualization tab the screen can be divided into different elements and
separately filled. Therefore two modes are available at the bottom: View and Con-
figuration. The View mode also provides the possibility to use a print mode and to
export or copy images to the clipboard. Beside visualizing plots you can also
insert text into the elements. The visualization tabs can be undocked and
arranged on the monitor according to your wishes. Tabs can be easily renamed
by double-clicking on it.

The Visualization step supports you in data comparison and to have your data
visualized at a glance in one overview.

TheOnly Marked Data option ( > Configure Single Element > Only Marked

Data) gives you a better overview, e.g. prediction vs. ignition angle per operating
point.
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4.5 Models
In ASCMO-MOCA, you can work with models provided as a set of formulas, or you
can import models created with ASCET, FMU, Simulink, ASCMO-STATIC or
ASCMO-DYNAMIC. These models can then be used as function nodes in the
ASCMO-MOCA project.

Importing and connecting external models is done in the Models Step.

ASCET models

If you want to use an ASCET model in ASCMO-MOCA, you have to create a
*.dll file with ASCET and ASCET-PSL first. This *.dll file is then added
to the ASCMO-MOCA project; see the online help for details.

ASCET models are used as black boxes by ASCMO-MOCA. You cannot
change the models, and no link to the ASCET model or to ASCET is created
during import.

FMU models

If you want to use an FMU model in ASCMO-MOCA, you have to create an
FMI *.fmu file first. This *.fmu file is then added to the ASCMO-MOCA pro-
ject; see the online help for details.

Note

FMU models that use FMI 2.x or FMI 3.x are supported by ASCMO-MOCA.
FMU models that use FMI 1 cannot be used.

Only the FMU file name is added to the ASCMO-MOCA project. You cannot
open the model itself. During optimization, the FMU model is used as a
black box: ASCMO-MOCA passes the inputs to the model, and receives the
outputs from the model. The way the model computes the output values
remains unknown to ASCMO-MOCA.
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The execution of Linux FMUs (i.e. no Win32 or Win64 binaries included in
the FMU) is supported, an appropriate Linux image must exist. An FMU with
Linux binaries can be run, if WSL2 (Windows Subsystem Linux) is installed.
The virtual machine needs ZeroC Ice and libgomp.

For example on Debian this can be installed by
sudo apt install libgomp1

sudo apt install libzeroc-ice3.7 libzeroc-ice zeroc-ice-

compilers zeroc-ice-slice

Take care that at least Ice version 3.7.6 is installed.

Simulink® models

Using Simulink® models in ASCMO-MOCA is described in detail in the
tutorial, see "Step 4: Models" on page 99.

ASCMO-STATIC and ASCMO-DYNAMIC models

These models are used as black boxes. After import of the models, the
ASCMO project isn't linked anymore and the models become part of the
ASCMO-MOCA project.

During import, you can select one, several or all outputs for import. Each
output is added as a separate model. See also section "Importing ASCMO-
STATIC/ASCMO-DYNAMIC Models" in the online help.

TSiM Plugin

If you want to use a TSiM Plugin in ASCMO-MOCA, you need a *.mexw64
file. This proprietary file format of Bosch is similar to FMU and typically rep-
resents control unit functions in a compiled form (DLL).

This format can be used in ASCMO-MOCA for simulations and optimization
of parameters.

For more information, see the online help (F1).

4.5.1 Steady State
Steady State is a concept used in the Models Step in ASCMO-MOCA for following
model types:

FMU models

Simulink models

TSiM PlugIn

It can only be applied if the imported data is static. This can be checked in the
Data Step (Data Sampling: Static (no time)).
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Steady state is a state in which all relevant variables are constant relative to each
other over time or grow at the same rate (steady development). That means the
state of equilibrium. 3 sizes can be specified.

Simulation Step Size: Define the simulation step size (base sample time).
This is specified in the model and must match.

Time until Steady State: This is the time span to wait until steady state is
reached (worst case scenario).

Average Last: Defining the duration of the average interval at the end of
Time until Steady State phase. Enter time in seconds to average the last
values and determine a mean value.

Fig. 4-6: Steady state visualization: the dark blue line is the average of the light
blue line
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4.6 Function
In ASCMO-MOCA, you can work with models provided as a set of formulas, or you
can import models created with Simulink, ASCET, ASCMO-STATIC or ASCMO-
DYNAMIC and connect them to the ASCMO-MOCA project.

Specifying a function formed by a set of formulas is done in the Function pane.

Data channels, parameters, other function nodes and imported models can be
used to define the expression of a function node. Several operators are available;
see " Mathematical Operators for Function Nodes" below.

You can export and import functions to and from text files that follow the formula
syntax. A sample export file is given here.

trqOpt[-] = %MapOptTorque%(%Speed%,%Rel_Airmass%)

ignOpt[-] = %MapOptIgnition%(%Speed%,%Rel_Airmass%)

deltaSpark[-] = %ignOpt% - %Ignition%

etaSpark[-] = %CurveEtaDeltaSpark%(%deltaSpark%)

product[-] = %SubFunction%(%deltaSpark%, %trqOpt%,

%CurveEtaDeltaSpark%)

dragTorque[-] = %MapDragTorque%(%Speed%,%Rel_Airmass%)

TorquePredict[-] = %product% - %dragTorque%

function SubFunction(InDeltaSpark : Data, IntrqOpt : Data,

myCurve : Curve)

curveOut[-] = %myCurve%(%InDeltaSpark%)

functionOut[-] = %curveOut% .* %IntrqOpt%

For more information, see the following subsections and the online help.

" Mathematical Operators for Function Nodes" below

"Step 5: Build Up the Function" on page 109 (tutorial)

4.6.1 Mathematical Operators for Function Nodes
Function nodes can be added and edited in the "Edit Node" window. At the right
side of that window, you can see buttons for common mathematical operators.
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The button, for example, adds the operation .* to the formula expression.
This operator results in a element-wise multiplication.

The button deletes the last inserted items.

z = x .* y element-wise multiplication

z = x ./ y element-wise division

z = x + y element-wise addition

z = x - y element-wise subrtaction

z = sqrt(x) square root of x

z = x.^y row-by-row x to the power of y

z = abs(x) absolute value

z = bswitch(x, y1, y2) row-by-row "if"

x ≤ 0 results in y1

x > 0 results in y2

e.g. limit x to positive values via bswitch
(%x%, 0, %x%)

z = min(x, y) row-by-row minimum

z = max(x, y) row-by-row maximum

z = x & y logical element-wise AND

z = x | y logical element-wise OR

z = cumsum(x) cumulated sum
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z = x < y logical row-by-row less than

also allowed: x ≤ y (<=)

z = x == y logical row-by-row equal

z = x > y logical row-by-row greater than

also allowed x ≥ y (>=)
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With the warnif button, you can define checks that are automatically
executed after each optimization run. If the defined condition is met,
the chosen warning text is shown in the log window. After clicking on
the warnif button, you have to insert a condition in the expression
field.

Example:

If at least one of the values of the map parameter MapDragTorque is
larger than zero after the optimization, the text Warning will appear in
the log window.

With the timeDelay button, you can delay a signal by one time step.

After clicking on the timeDelay button, you have to insert a con-
dition in the expression field: timeDelay(x, intialValue)

Example:

x = Node transferFcn
initialValue = 1. timestep of Input setpoint

See Main Function in Demo Project Function Closed-Loop (PI con-
troller)

Note

ASCMO-DYNAMIC models can run inside a feedback loop with
timeDelay and can be used in the function. This enables optim-
ization of control algorithms e.g. a PID controller with an ASCMO-
DYNAMIC model. See Main Function in Demo Project ASCMO
Dynamic Model Closed-Loop (PI Controller)
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dT will be replaced with the value of the sample time in the data.

Example:

dT = Values of time [s] column in Data Step
%filterConstant% = Parameter

See pt1 Function in Demo Project Function Closed-Loop (PI controller)

With the roundTo button, you can round a node to a specific value.

After clicking on the roundTo button, you have to select a discrete
parameter and enter the values.

Example:

In this example, you want to observe output of calibration map dis-
crete. Calibration Map calMap_SCV is rounded to values 0 and 1.

See also exported ASCMO-STATIC Demo Project opened in ASCMO-
MOCA usingOptimization → Export to MOCA in ASCMO-STATIC,
checkbox “Replace Discrete Inputs by Continuous Inputs” must be
deactivated.

With steadyState_abs(, you can calculate the steady state of a sig-
nal based on the window length and window height.
steadyState_abs(x, windowLength, windowHeight,

sampleRate)

Example:

steadyState_abs(%signal%, 10, 200, dT)

The following operators are supported, but must be entered manually.

z = atan

(x)
Inverse tangent. Result is in radians. Also allowed: cos, sin, asin,
acos, tan, tanh.

z = x ~=

y
Logical row-by-row unequal.

z = log

(x)
Logarithm to the radix e.

Euler's number, i.e. 2.71828 18284...
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z = exp
(x)

e to the power of x

z = bit-
get(x,
bitPos)

MATLAB® function bitget returns a bit value of specified position.
This can be used to get bit at specified position.
4 =>100
bitget(4, 3) returns 1
bitget(4, 2) returns 0

Note

ASCMO-MOCA supports nearly all operators available in MATLAB®, if the deriv-
ative of the resulting formula can be calculated.

See online help (F1) for further information (section "button area" in "Insert/Edit
Node" Window).

4.6.2 Feedback Loop
Within a node of the Function you can access a future node using a feedback
loop with time delay. This can be also used with a dynamic model. See the fol-
lowing graphic and ASCMO-MOCA example.
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Main Function Nodes
engine_speed[-] = timeDelay(%Output%, 0)

engine_torque[-] = %PID Controller%(%engine_speed_setpoint%,

%engine_speed%, %Ki%, %Kp%)

Output[-] = %Plant%(%engine_torque%)

PID Controller Function Nodes
diff[-] = %engine_speed_setpoint% - %engine_speed_act%

diff_integrated[-] = timeDelay(%diff_integrated%, 0) + dT .*

%diff%

engine_torque[-] = %Kp% .* %diff% + %Ki% .* %diff_integrated%
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The timeDelay element is one of the mathematical operators in the "Insert/Edit
Node" window.

4.7 Optimization
This section contains a description of the different optimization methods and the
optimization criteria that can be used for the parameter optimization.

This section contains the following subsections:

"Description of the Optimization Method" below

"Consideration of the Roughness" on page 58

"Optimization Criterion" on page 59

"Optimization Without Sequence" on page 60

"Optimization With a Sequence" on page 60

"Parameter Correlation" on page 61

"Parameter Sensitivity" on page 62

4.7.1 Description of the Optimization Method
The optimizer calibrates the p calibration values of the maps/curves with the
goal to minimize the deviation between the measured, predetermined values and
the predicted n values.

Equ. 4-5: Optimization method

where
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p calibration values

n number of measurement points

Ypredicted prediction of the function in ASCMO-
MOCA/ASCMO-MOCA Runtime

Ymeasured the imported data

Wo Weight of Optimization

Wc Weight of Constraint

Wg Weight of Gradient, 1..D dimensions

Wk Smoothness factors, 1..D dimensions

The squared deviation is minimized, where the square has the effect that larger
deviations are penalized even stronger.

Based on this general formula, smoothness, local constraints and gradient limits
can be added. This can be expressed in the following formulas.

Smoothness

See 4.7.5 "Optimization Criterion" on page 59

Gradient Limits

See "Optimization Criterion" on page 59

Local Constraints

4.7.2 Optimization Algorithms
In theOptimization step, you can choose from the following optimization
algorithms:

"Default (Gradient Descent)" on the next page

"Respect Constraints (Gradient Descent)" on page 49

"Gradient-free Optimizer" on page 49

"Surrogate Optimizer (Global Optimization)" on page 49

"Genetic Algorithm (Global Optimization)" on page 49

"Simulated Annealing (Global Optimization)" on page 50

"Particle Swarm (Global Optimization)" on page 50
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Gradient Descent vs. Global Optimization
Gradient descent optimization starts with the working parameter set as initial val-
ues and uses the gradient of the cost function to iteratively follow the direction
of the steepest descent to the minimum of the cost function. The gradient des-
cent optimizer only finds a local minimum, so the starting position of the optim-
ization is important.

ASCMO-MOCA calculates the gradients of the function analytically. Gradients
from external models, such as Simulink or FMU models, are computed using the
finite difference method. This allows the optimizer to find the local minimum
quickly and with a minimum number of function evaluations. The memory con-
sumption is at least the number of data points multiplied by the number of para-
meters and multiplied by two for the optimization algorithm itself.

Global optimizers are gradient-free optimizers that try to find a global optimum.
They start with several random candidate solutions to the optimization problem
spread over the entire search space. Then the search space is iteratively nar-
rowed down to good, more accurate solutions. The optimization may not hit the
optimum perfectly, so you can start with a global optimization to find the global
optimum, and then continue with a gradient descent optimization to refine the
result.

A typical optimization problem in ASCMO-MOCA is the optimization of maps and
curves. Such an optimization problem usually has many parameters (e.g., a 20x20
map has 400 parameters), and a global optimizer may require many iterations to
find a good solution.

Being gradient-free, global optimization can find a solution when the gradients of
a function/model are not continuous. This happens when your model is imple-
mented with a fixed-point representation of numbers or parameters and inputs
or outputs are discrete. It can also happen if your model is implemented with 32-
bit instead of 64-bit floating point numbers.

Default (Gradient Descent)
This is a gradient descent least squares optimizer. It was chosen as the default
optimizer because it performs well when the optimization task has many para-
meters, which is likely when using maps and curves.

The residuals enter the optimization algorithm as a vector, so the optimizer gets
100 residuals for a dataset with 100 data points. This is computationally expens-
ive, but leads to good optimization results.

The residuals are implicitly squared by the optimizer, so the difference from a ref-
erence value is always minimized. To do a minimization or maximization, you must
explicitly provide a low/high value to optimize against.
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EXAMPLE
The output is in the range 0 to 1000. To do a maximization, define the optim-
ization criterion asminarg(y(x)-1000).

Local constraints enter the optimization as part of the sum formula (W * Con-

straint). In the context of ASCMO, this is called a soft constraint. The weight of
such a local constraint is increased every 10 iterations until the constraint is sat-
isfied.

During optimization, the weight of the constraint is increased if the constraint is
violated. This may not be sufficient, and the constraint may still be violated after
optimization.

Respect Constraints (Gradient Descent)
This is also a gradient descent least squares optimizer, but it takes constraints
into account.

The constraints are treated by the optimizer as hard bounds. The default optim-
izer should be preferred unless the constraints are violated. Use this algorithm if
a constraint is violated after optimizing with the default optimizer.

Gradient-free Optimizer
The gradient-free Optimizer uses a simplex algorithm for optimization. The
algorithm does not depend on gradients and therefore requires more iterations
than a gradient descent algorithm. The solutions are typically not as good as
those of a gradient descent optimizer.

Use this gradient-free optimizer when the gradients of the function/model are
not continuous. This happens when your model is implemented with a fixed-point
representation of numbers or parameters and signals are discrete. It can also hap-
pen if your model is implemented with 32-bit instead of 64-bit floating point num-
bers.

Surrogate Optimizer (Global Optimization)
The Surrogate Optimizer tries to find a global optimum. It first builds a surrogate
model and then optimizes it instead of the original function/model. This can be
useful if the function/model evaluation takes a long time.

Genetic Algorithm (Global Optimization)
The Genetic Algorithm tries to find a global optimum. It is inspired by natural selec-
tion and the exchange of genomes. It starts with random candidate solutions,
here called a population, see Wikipedia: Genetic Algorithm for more details. The
size of the population strongly influences the memory consumption. An optim-
ization task with many signals and/or data can lead to out-of-memory problems.
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Reducing the population size frees up memory. The algorithm performs a vec-
torization with all candidate solutions and can perform model evaluations of FMU
and TSim models in parallel.

Simulated Annealing (Global Optimization)
Simulated Annealing tries to find a global optimum. It starts with random can-
didate solutions at the beginning of the optimization. Due to a high initial tem-
perature, large parameter changes are possible. Over several iterations, the
temperature decreases, limiting possible parameter changes and allowing more
accurate solutions to be found. See Wikipedia: Simulated Annealing for more
details. The number of particles strongly affects the memory consumption. An
optimization task with many signals and/or data can lead to out-of-memory prob-
lems. Reducing the number of particles frees up memory.

Particle Swarm (Global Optimization)
Particle Swarm tries to find a global optimum. It starts with random candidate solu-
tions, called particles. The particles have a position and a velocity. It starts with a
high velocity and over several iterations the velocity decreases, allowing more
accurate solutions to be found, see Wikipedia: Particle Swarm Optimization for
more information. An optimization task with many signals and/or data can lead to
out-of-memory problems. Reducing the number of particles frees up memory.
The algorithm performs a vectorization with all candidate solutions and can per-
form model evaluations of FMU and TSim models in parallel.

4.7.3 Optimizer Options
From theOptimization Algorithm drop-down list, select the optimization
algorithm for which you want to customize the settings:

Default

With time-delay Code Generation
When activated, C code is generated from the function and optimization
works on compiled C code. This only works if the function does not use
external models. This speeds up the optimization when the timeDelay
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method is used in the function, in other cases it's usually slower.

Iterations
Enter the maximum number of iterations to be performed during optimization.

Multistart
Enter the number of times to run the optimizer with different initial values.

If set to a number greater than one, the optimizer will run multiple times. The
first optimization is started with the current working parameter set, while sub-
sequent optimizations start with random parameter values. This can be used
to find a global optimum.

Tolerance
The optimization stop criterion. Typical values range from 1e-9 to 1e-16.

The value is used to stop the optimization in the following cases:

A parameter change by the optimization algorithm would be smaller than
this value.

The change in the cost function is smaller than this value. The optimization
has converged.

Finite Difference Factor
The gradients of external models (FMU, …) are calculated by finite gradients.

Gradient = (f(x+e) - f(x)) / e

with e = Finite Difference Factor * Normalized Parameter Range * 1.5e-8

If the output of a model does not change by such a small value, the optimizer
stops at the first iteration. In this case, the Finite Difference Factormust be
increased. Typical values are 10, 100, 1000, 10,000,...

1.5e-8 is the square root of the smallest number that can be shown with a
double precision floating point number. If the model uses single precision float-
ing point numbers, set the factor to 10,000 to consider the loss of precision.

Respect Constraints
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With time-delay Code Generation
When activated, C code is generated from the function and optimization
works on compiled C code. This only works if the function does not use
external models. This speeds up the optimization when the timeDelay
method is used in the function, in other cases it's usually slower.

Iterations
Enter the maximum number of iterations to be performed during optimization.

Multistart
Enter the number of times to run the optimizer with different initial values.

If set to a number greater than one, the optimizer will run multiple times. The
first optimization is started with the current working parameter set, while sub-
sequent optimizations start with random parameter values. This can be used
to find a global optimum.

Tolerance
The optimization stop criterion. Typical values range from 1e-9 to 1e-16.

The value is used to stop the optimization in the following cases:

A parameter change by the optimization algorithm would be smaller than
this value.

The change in the cost function is smaller than this value. The optimization
has converged.

Finite Difference Factor
The gradients of external models (FMU, …) are calculated by finite gradients.

Gradient = (f(x+e) - f(x)) / e

with e = Finite Difference Factor * Normalized Parameter Range * 1.5e-8

If the output of a model does not change by such a small value, the optimizer
stops at the first iteration. In this case, the Finite Difference Factormust be
increased. Typical values are 10, 100, 1000, 10,000,...

1.5e-8 is the square root of the smallest number that can be shown with a
double precision floating point number. If the model uses single precision float-
ing point numbers, set the factor to 10,000 to consider the loss of precision.

Gradient-free Optimizer
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With time-delay Code Generation
When activated, C code is generated from the function and optimization
works on compiled C code. This only works if the function does not use
external models. This speeds up the optimization when the timeDelay
method is used in the function, in other cases it's usually slower.

Iterations
Enter the maximum number of iterations to be performed during optimization.

Multistart
Enter the number of times to run the optimizer with different initial values.

If set to a number greater than one, the optimizer will run multiple times. The
first optimization is started with the current working parameter set, while sub-
sequent optimizations start with random parameter values. This can be used
to find a global optimum.

Tolerance
The optimization stop criterion. Typical values range from 1e-9 to 1e-16.

The value is used to stop the optimization in the following cases:

A parameter change by the optimization algorithm would be smaller than
this value.

The change in the cost function is smaller than this value. The optimization
has converged.

Surrogate Optimization
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With time-delay Code Generation
When activated, C code is generated from the function and optimization
works on compiled C code. This only works if the function does not use
external models. This speeds up the optimization when the timeDelay
method is used in the function, in other cases it's usually slower.

Iterations
Enter the maximum number of iterations to be performed during optimization.

Multistart
Enter the number of times to run the optimizer with different initial values.

If set to a number greater than one, the optimizer will run multiple times. The
first optimization is started with the current working parameter set, while sub-
sequent optimizations start with random parameter values. This can be used
to find a global optimum.

Tolerance
The optimization stop criterion. Typical values range from 1e-9 to 1e-16.

The value is used to stop the optimization in the following cases:

A parameter change by the optimization algorithm would be smaller than
this value.

The change in the cost function is smaller than this value. The optimization
has converged.

Min. Surrogate Points
The surrogate model is a radial basis function model, and the minimum num-
ber of basis functions used in the model is defined here. The initial model is
assessed at the location of these basis functions.

Genetic Algorithm
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With time-delay Code Generation
When activated, C code is generated from the function and optimization
works on compiled C code. This only works if the function does not use
external models. This speeds up the optimization when the timeDelay
method is used in the function, in other cases it's usually slower.

Use Vectorized
If activated, the MOCA function is evaluated with all candidate solutions in a
single vectorized call. The function's memory usage increases by a factor pro-
portional to the number of individuals in the population during the evaluation
process.

Iterations
Enter the maximum number of iterations to be performed during optimization.

Multistart
Enter the number of times to run the optimizer with different initial values.

If set to a number greater than one, the optimizer will run multiple times. The
first optimization is started with the current working parameter set, while sub-
sequent optimizations start with random parameter values. This can be used
to find a global optimum.

Tolerance
The optimization stop criterion. Typical values range from 1e-9 to 1e-16.

The value is used to stop the optimization in the following cases:

A parameter change by the optimization algorithm would be smaller than
this value.

The change in the cost function is smaller than this value. The optimization
has converged.
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Population Size
The number of candidate solutions available during the optimization process.
Increasing the population size may lead to better solutions, but also results in
longer processing times and higher memory usage. The usual range for this
value is between 100 and 1000.

Elite Count
The number of good candidate solutions that are carried over unchanged to
the next iteration. Using a smaller number causes the algorithm to converge
at a slower pace. Common values range from 5 to 20% of the overall pop-
ulation size.

Crossover Fraction
Crossover candidate solutions are produced by combining two candidates.
Mutated candidate solutions are created by changing a candidate at random.
The crossover fraction controls the amount of crossover and mutation, with a
range of 0 to 1. A value of 0.8 means that 20% of candidates undergo muta-
tion, while 80% are produced by crossover. Typically, values range from 0.5 to
0.9.

Simulated Annealing

With time-delay Code Generation
When activated, C code is generated from the function and optimization
works on compiled C code. This only works if the function does not use
external models. This speeds up the optimization when the timeDelay
method is used in the function, in other cases it's usually slower.

Iterations
Enter the maximum number of iterations to be performed during optimization.

Multistart
Enter the number of times to run the optimizer with different initial values.
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If set to a number greater than one, the optimizer will run multiple times. The
first optimization is started with the current working parameter set, while sub-
sequent optimizations start with random parameter values. This can be used
to find a global optimum.

Tolerance
The optimization stop criterion. Typical values range from 1e-9 to 1e-16.

The value is used to stop the optimization in the following cases:

A parameter change by the optimization algorithm would be smaller than
this value.

The change in the cost function is smaller than this value. The optimization
has converged.

Initial Temperature
This value controls the probability of accepting worse solutions during the
optimization process. Typical values range from 50 to 200.

The initial temperature decreases by Initial Temperature * 0.95Iterations per
iteration. As the temperature decreases, the probability of accepting worse
solutions decreases.

Reannealing Interval
After this number of iterations, the temperature is increased. Typical values
are 50 to 200.

Particle Swarm

With time-delay Code Generation
When activated, C code is generated from the function and optimization
works on compiled C code. This only works if the function does not use
external models. This speeds up the optimization when the timeDelay
method is used in the function, in other cases it's usually slower.

Iterations
Enter the maximum number of iterations to be performed during optimization.
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Multistart
Enter the number of times to run the optimizer with different initial values.

If set to a number greater than one, the optimizer will run multiple times. The
first optimization is started with the current working parameter set, while sub-
sequent optimizations start with random parameter values. This can be used
to find a global optimum.

Tolerance
The optimization stop criterion. Typical values range from 1e-9 to 1e-16.

The value is used to stop the optimization in the following cases:

A parameter change by the optimization algorithm would be smaller than
this value.

The change in the cost function is smaller than this value. The optimization
has converged.

Swarm Size
The number of candidate solutions available during the optimization process.
Enlarging the swarm size leads to longer optimization duration and increased
memory usage, but may lead to better solutions. Typical values range from 50
to 200.

For an explanation of the optimization algorithms, see "Optimization Algorithms"
on page 47

4.7.4 Consideration of the Roughness

Roughness of a Curve
The roughness r describes the change in the slope at the support points of the
curve c. If the curve is given by an expression c(x), the roughness is given as the
sum of the second derivatives at the support points xi, i=1..k.

For a curve, this means:

Equ. 4-6: Roughness r of a curve

Roughness of a Map
The Roughness of a map m = m(x1, x2) has to consider the second input variable
and therefore is defined as:
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Equ. 4-7: Roughness of a map

where K is the number of the support points (x11, x21), ... , (x1K, x2K) of the map.

The roughness is shown in the "Parameter Optimization Properties" Window
(Optimization Step > Optimization Criteria button).

4.7.5 Optimization Criterion
To optimize one or more outputs, there is the target criterion Smoothness that
limits the variation of the stiffness (see "Consideration of the Roughness" on the
previous page) of a map or a curve. This factor is a weighted penalty term,

Equ. 4-8: Smoothness factor Si

where S is the Smoothness factor and M the number of support points of the
map or curve.

Different Smoothing Factors in X/Y Direction
For maps, Cube-3D and Cube-4D, the smoothing factor S is used per input dir-
ection. If only one value is given, the factor works for all directions. If a vector is
given, each element corresponds to one input direction. In case of a map, e.g.,
one may set smoothness in X direction to 0.1 and in Y direction to 0.001 by spe-
cifying a vector [0.1 0.001].

The smoothing factor has to be a real number ≥ 0 and can be defined in the
Optimization Step either via theOptimization Criteria button or by directly edit-
ing the column "Smoothness" in the parameter table.

Optimization Criteria Selection
For curves, maps, Cube-3D and Cube-4D, the gradients in each respective input
direction can be constrained by defining a limit for the maximal and/or the min-
imal gradient. The gradient constraints can be defined in the Optimization Step
via theOptimization Criteria button. All gradient constraints are handled as
weak constraint by the optimizer.

You can also assign a weight to each set of gradient limits. This weight sets the
priority of the gradient limits in relation to the primary optimization criteria. A
higher weight makes the gradient limits more important.
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A step-by-step instruction how to set an optimization criterion is given in the
online help.

4.7.6 Optimization Without Sequence
Unless your project must fulfill special requirements, all steps for optimization are
performed in the "Optimize" tab of the Optimization pane:

preparing the optimization
l specifying optimization options
l specifying optimization criteria
l specifying local constraints

running the optimization

performing optional activities
l showing data
l dealing with reference parameters

See the online help for instructions how to do these steps.

4.7.7 Optimization With a Sequence
If your project must fulfill special requirements, you can define a sequence of
optimization steps in the "Sequence" tab of the Optimization Step.
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Special requirements can be, e.g., the following:

First, one map shall be calibrated with a part of the data.

Then the result of the first map is kept and the other parameters are cal-
ibrated.

Once your sequence is complete, you can run the optimization.

See the online help for instructions how to create and run an optimization
sequence.

4.7.8 Parameter Correlation
You can use the Analysis > Parameter Correlationmenu option to check if the
parameters are correlated. A strong correlation (+1 or -1) means that two para-
meters do not independently affect the function node. To determine the cor-
relation, the following happens.

ASCMO-MOCA calculates the gradient matrix G regarding all parameters:

with

F - the optimization function to be minimized

x - training data

p - parameter

ASCMO-MOCA then calculates the covariance matrix C:

with
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GT - transpose of G

I - identity matrix

Then the correlation coefficients c between parameters a and b are calculated.
Cab, Caa, and Cbb are elements of the covariance matrix.

The results are displayed in the "Parameter Correlation" window.

4.7.9 Parameter Sensitivity
You can use the Analysis > Normalized Parameter Sensitivitymenu option to
check the influence of parameters on function nodes.

ASCMO-MOCA calculates the gradients G of a node regarding the parameters for
all parameters pj for all training data points xi:

with

F - the optimization function to be minimized

x - training data

p - parameter

The gradient is normalized to the range of the parameter:

with

uj - upper limit of parameter pj
lj - lower limit of parameter pj

The results are displayed in the "Normalized Parameter Sensitivity" window as fol-
lows:

Fig. 4-7: Normalized parameter sensitivity
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dark gray area: maximum gradient regarding one parameter pj over all train-
ing data points

red line: mean gradient regarding one parameter pj over all training data
points

light gray area: mean gradient ± 1 σ regarding one parameter pj over all
training data points

Note

Smaller values indicate less influence of the parameters on a node.

4.8 Symbolic Regression
Symbolic regression is a type of regression analysis on a symbolic level. Trans-
ferred to an application in the context of ASCMO-MOCA, this means to auto-
matically find an equation-based or hybrid (mixing equation- and data-based
approaches) model with the following properties:

Model corresponds to a dataset well in a statistical sense.

Model is as compact as desired.

Model is human-interpretable.

The symbolic regression plugin of ASCMO-MOCA provides a solution to this task
by carrying out optimizations on the structural level of equations and local optim-
izations to fit identified models to data. In terms of embedded software function
engineering these two steps correspond to function engineering and calibration,
respectively.

ASCMO-MOCA supports engineers carrying out this steps more efficiently and
effectively using artificial-intelligence. From an alternative perspective, the
method can also be viewed as an automated way of system identification.

The Symbolic Regression Feature is located in the Function Step.

4.8.1 Symbolic Regression Workflow
Symbolic Regression supports you to derive automatically a formula from the
data with a genetic algorithm. You can also use Symbolic Regression for (time-
dependent) dynamic functions with time-delay.
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The workflow to carry out Symbolic Regression is comprised of several steps.

Data Acquisition:
Acquire data which describes the system well. The dataset size should
allow for a meaningful split into training, validation, and test data.
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Preparations and Data Import:
Requirements for Data
l Clean: all values are meaningful, no NaNs given, no errors from defect

measurement devices, etc.
l Labeled: For all values the measured value (label) is defined along with

its units.
l Splittable: The dataset can be split into training, validation and test

data. All being representative in a statistical sense.
After data preparation, start import.

Algorithm Configuration:
l Start the algorithm configuration with Start Symbolic Regression but-

ton in the Function Step.
l Define the regression problem by setting the target quantity in the field
Target and choose the input quantities by shifting them from Available
Inputs to Selected Inputs.

l Configure the algorithmic details in the fields belowOptimization Con-
figuration. See Algorithmic Details.

l Choose the function/operation types you want to use by clicking on the
elements below Selected Alphabet.

Execution:
Start the algorithmic execution by clicking onOK in the "Symbolic Regres-
sion" window and stop the execution at any time by clicking on Stop in the
status bar beneath log window (main window). In the log window on the
command line you will see the value of the selected Fitness Method for
the best model which was found at the current iteration step.

Model Choice:
Once the algorithm is finished, ASCMO-MOCA will open a window showing
the pareto-front. The latter is made of the models contained in the pareto-
set. The pareto-set is defined in the space spanned by Fitness Method (y-
axis) and Complexity (x-axis). Click on the bubbles to select a model. You
will see the value of the currently selected Fitness Method right at the
bubble. Additionally ASCMO-MOCA provides you with the selected model in
the Function Step.

Statistical Analysis: Evaluate the performance of the selected model in a
statistical sense by choosing Analysis > Residual Analysis. See also Resid-
ual Analysis.

Structural and Semantic Analysis:
The Function and Parameters Step allow you to analyze and interpret the
model on a structural and semantic level, respectively. The Function Step
gives you an inside into the model itself.
The Parameters Step allows a detailed inspection of all parameters and
maps, which are used by the model of your choice.
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Structure Adaption and Re-Optimization:
ASCMO-MOCA seamlessly allows you to adapt the model structure as
described in Functions. Once done, you can carry out a re-optimization of
this structure. See also "Optimization" on page 46.

4.8.2 Algorithmic Details of Symbolic Regression

Fig. 4-8: Algorithmic Details of Symbolic Regression

To carry out symbolic regression, ASCMO-MOCA uses a modified version of
genetic programming. The algorithm is specifically suited to fulfill the required
task. The major algorithmic steps are described below and in the image.

Function Set
A set of functional expressions is defined which are used during the course of
the algorithm. In ASCMO-MOCA this step is covered by choosing the func-
tion/operation types you want to use by clicking on the elements in the "Selected
Alphabet" area.

Population
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After the function set is defined, a population/set of models is created on a
stochastic basis. Starting with this step the models are represented as graphs.
The creation process is constrained w.r.t. the population size and the graphs'
dimensions. During the course of the algorithm the population evolves from the
evolution operations. Each iteration-step in the main loop of the algorithm cor-
responds to one generation.

Corresponding Configuration Parameters (Optimization Configuration & Initial
Configuration) in the "Symbolic Regression" window

Random Seed: Integer used as the seed for the random number gen-
eration, which effects all stochastic steps within the algorithm. Modify this
value to improve the performance in critical cases.

Population Size: Number of models contained in each population. For hard
problems population sizes of several thousands have performed well.

Population Creation Method (Initial Configuration): The initial pop-
ulation is created with one of the three different methods. For unknown
problems the half-and-half methods is a good choice.
l half and half: One half of the population is created with full method and

the other half of the population is created with the grow method. The
used maximum depth value is determined from a uniform distribution
within Population Init Depth Min and Population Init Depth Max, for
each graph individually.

l full: Each graph is created such that it has a depth of Population Init
Depth Max in all branches.

l grow: Each graph is created such that at least one branch has a depth
of Population Init Depth Max.

Population Init Depth Min: Minimum initial depth.

Population Init Depth Max: Maximum initial depth. Graphs with a depth of
ten are already huge and very complex. Numbers around four are more
appropriate.

Max Program Complexity (Optimization Configuration): No graphs are
created (initially and during evolution) having a larger complexity. A graphs'
complexity is an integer given by the sum of complexities of all nodes the
graph is made of. Node complexities are defined ASCMO-MOCA internally
based on experience. Using this option offers you to fasten the algorithm's
execution if you have a clear expectation and experience on the com-
plexity for your symbolic regression problem.

Max Program Depth: No graphs are created (initially and during evolution)
having a larger depth.

Max Program Size: No graphs are created (initially and during evolution)
having a larger size (number of nodes).

Datasets
Naturally, symbolic regression requires one or several datasets to be carried out.
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Optimization
For each graph an individual and local optimization is performed. The goal of this
optimization is to minimize the value obtained by using the method given by the
Fitness Method.

Corresponding Configuration Parameters (Optimization Configuration)

Optimizer Method
l Levenberg-Marquardtmethod (LM)
l Trust-region-reflectivemethod
l Dogbox algorithm

Optimizer Iterations: Maximum number of iterations the local optimization
should be carried out.

Termination criteria fulfilled Request
The algorithm stops if one of the following criteria holds:

It holds for one of the models in the population that the value obtained by
using the method given by the Fitness Method is smaller than the ter-
mination threshold.

The maximum number of generations is reached.

Corresponding Configuration Parameters (Optimization Configuration)

Termination Threshold: Threshold used for termination. The threshold is a
positive double.

Number of Generations: Maximum number of generations.

Fitness
For each model in the population it's fitness is computed. To do so the raw-fit-
ness is computed as the sum of two parts:

1. The value obtained by using the method given by the fitness method, the
cost-function.

2. A scalar value penalizing the complexity of the graph.

The actual fitness itself is obtained from normalizing the raw-fitness to values
within [0,1].

Corresponding Configuration Parameters (Optimization Configuration)

Fitness Method: Various cost-function types are available.
l rmse Root mean squared error.
l mseMean squared error.
l abs Normalized absolute difference (mean of L^1-norm).

Parsimony Coefficient: Factor to weight the impact of the complexity pen-
alty. For unknown problems, a value of 1 is a reasonable starting point. For
smaller values of the Parsimony Coefficient the formula gets more com-
plex.

Program Selection
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The structural optimization of the graphs starts with selecting graphs from the
population. The selection is done on the basis of the fitness obtained in the pre-
vious step, with the methods described below.

Corresponding Configuration Parameters (Optimization Configuration)

Program Selection Method:
l tournament: From the given population Tournament Size graphs are

randomly drawn from the population and the one with the best fitness is
selected.
> Tournament Size: Number of programs to select from tournament.
Choosing the minimum of 2 individuals will lead to highly volatile pro-
gress of the algorithm. If the number converges to Population Size, a
dominance of the fittest programs is enforced. Choosing about 10% of
the Population Size is a good starting point.

l fitness-based: A probability distribution is derived from the fitness of all
graphs in the current population. This distribution is sampled to select
graphs. The fitter a graph is, the more likely it will be selected.

l greedy overselection:The population is divided into a high-fitness
group and a low-fitness group. For both groups fitness-based selection
is used. If the high-fitness group is used it is determined with Prob-
ability Top. Otherwise the low-fitness group is chosen.
> Fraction Top: The fraction of the population defines the size of the
high-fitness group. The group is filled with the graphs having the
highest fitness.
> Probability Top: Probability with which the high-fitness group is used
for fitness-based selection.

l multi tournament: Similar to tournament. With a selectable probability,
however, fitness/complexity is taken as a criterion instead of just fit-
ness. This option states the a multi-criterial optimization possibilities,
only given for a gradient-free technique like genetic programming.
> Tournament Size: Number of programs to select from tournament.
Choosing the minimum of 2 individuals will lead to highly volatile pro-
gress of the algorithm. If the number converges to Population Size, a
dominance of the fittest programs is enforced. Choosing about 10% of
the Population Size is a good starting point.
> Probability Fitness: Probability to use fitness/complexity instead of
fitness.

Evolution
The evolution step comprises the graph-modification operations of reproduction,
expansion, mutation, and crossover. It is the actual structural optimization step
and relies on the graph selected in the previous step. The probabilities for the dif-
ferent techniques determine how likely they are to be applied to this graph.

Corresponding Configuration Parameters (Evolution Probabilities)
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For the four options, each probability defines how likely the according option is
carried out. The sum of the probabilities has to equal 100.

Crossover Probability: Setting it in the range of 80 - 90 is a meaningful
choice.

Reproduction Probability: This operation ensures that graphs with a good
fitness are likely to be taken-over unchanged to the next generation.

Expansion Probability

Mutation Probability

Reproduction

Reproduction of a graph simply means to take it over as-is in the population of
the next generation.

Expansion

The expansion of a graph is carried out by:

randomly selection a terminal node of the graph,

creating a new random graph with depth two,

replacing the terminal node by the new graph.

If the expanded graph has a better fitness than the original one, it is taken over to
the next generation. Else, the original graph is taken over as-is.

Mutation

A mutation of a graph is be carried out with three different operations, each of
them being applied to a randomly selected node of the graph.

New Tree: The selected node and all sub-nodes are replaced by a newly
created graph with a maximum depth of three.

Hoist: The selected node of the graph is removed, keeping the consistency
of the graph. This method helps to prevent bloat of the graphs.

Point: The selected node is replaced by a random node with the same num-
ber of inputs.

How likely which method is applied is determined by the individual probability. The
sum of all three probabilities has to equal 100.

Corresponding Configuration Parameters (Mutuation Probabilities)

New Tree: Probability to carry out the new tree operation.

Hoist: Probability to carry out the hoist mutation operation.

Point: Probability to carry out the point mutation operation.

Crossover

The crossover operation essentially is about recombining two graphs to find an
even more fitter one. The operation is carried out by the following steps:

1. The graph selected in the previous step is defined as the target graph.

2. A second graph is selected – exactly as described in Program Selection –
and defined to be the source graph.
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3. In both graphs one node with all its sub-nodes is selected randomly as
branches to-be-exchanged.

4. The branch in the target graph is replaced by the branch of the source
graph.

The resulting graph is taken over to the population of the next generation.

Reached Population Size Request
The evolution operations are applied until the population of the next generation
has Population Size number of members.
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5 Working with ASCMO-MOCA

5.1 User Interface of ASCMO-MOCA
This section provides an overview of the user interface of ASCMO-MOCA.

A detailed description of the functions of the main menu and the various dialog
windows associated with it is located in the context-sensitive online help (<F1>
or Help > Online Help).
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5.2 Elements of the ASCMO-MOCA User Interface
This chapter provides a brief overview of the user interface key elements. The fol-
lowing figure shows the main user interface of ASCMO-MOCA.

Fig. 5-1: Main user interface elements of ASCMO-MOCA

Most of the user activity will take place in the main working window. Moreover,
there is a number of interactive options in the navigation and the main menu bar
that are described below.

➀ Main menu

➁ Toolbar (see "Toolbar" below)

➂ Navigation pane (see "Navigation Pane of ASCMO-MOCA" on page 75)

➃ Main working window

➄ Log window (see "Log Window" on page 76)

Status bar (footer) with current state information

5.2.1 Main Menu of ASCMO-MOCA
For details of the functions of the main menu, refer to the online help (<F1> or
Help > Online Help).

5.2.2 Toolbar
The toolbar contains a number of buttons that will run the following functions.
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New project Opens a new instance of ASCMO-MOCA.

Open project Opens a data selection dialog where you can
open available projects (*.moca).

Save Saves the current project.

Scatter plot for train-
ing data

Opens the Data and Nodes - Training Data
window.

See also "Graphical Analysis of Data and
Function Nodes" on page 20.

Scope view of resid-
uals, function eval-
uation and training
data

Opens the Scope View - Training Datawin-
dow.

Open visualization in
separate window

Pause evaluation Pauses the evaluation of functions and
external models unless you clickOptimize.

When activated, only NaNs are returned.

Recalculate once, even if pause is active, update RMSE display

Select active data-
sets

Opens the Active Datasets window.

Automatically quant-
ize all parameters
and limits of all para-
metersets on para-
meter change

Automatic quantization automatically applies
the A2L conversion formula after a para-
meter change. Quantization is not active dur-
ing optimization, but is applied when
optimization is finished.

Zoom in By clicking in the plot, the visualization
becomes larger.

Zoom out By clicking in the plot, the visualization
becomes smaller.

Pan This button allows you to move the plot
within the window.

Rotate 3D This button allows you to rotate a plot in all
dimensions.

Only available for the Visualization step

Add x axis cursor in plot

Add y axis cursor in plot

Mouse selection in plot with rectangle
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Mouse selection in plot with lasso

Hide all selections

Undock current visu-
alization in separate
window

Undocks current visualization tab into a sep-
arate window.

Lock visualization
against changes

Locks the visualization of all tabs against
changes unless you clickOptimize.

5.2.3 Navigation Pane of ASCMO-MOCA
The navigation pane at the left side of the window leads you through the process
steps from the import of the measuring data up to the export of the optimized
parameters.

1 – Data: Opens the Data Step in the main working window. Here, you can import a
measurement file, edit the measurement data and export the data to a meas-
urement file. In addition, the data channel from the measurement file can be
mapped to the respective function variable (Channel Name Mapping).

Further information can be found in "Data" on page 19, in the tutorial (see "Step 1:
Data Import" on page 81), and in the online help

2 –Models: Opens the Models Step in the main working window. You can import
models and link the parameters, inputs and outputs with the available para-
meters in ASCMO-MOCA.
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Note

To use a Simulink® model in ASCMO-MOCA, Simulink® installation with a valid
license is required.

Further information can be found in section "Models" on page 36, in the tutorial
(see "Step 4: Models" on page 99), and in the online help.

3 – Function: Opens the Function Step in the main working window. The function
will be constructed from the stepwise creation of the nodes. The main point here
is the linkage of the parameters and the data.

Further information can be found in "Function" on page 39, in the tutorial (see
"Step 5: Build Up the Function" on page 109), and in the online help.

4 – Parameters: Opens the Parameters Step in the main working window. Here,
you can manage and change maps, curves, scalars, cube-3D, cube-4D cube, com-
pressed model and matrix for the usage in the Function Step.

Further information can be found in "Parameters " on page 26, in the tutorial (see
"Step 3: Parameters" on page 98), and in the online help.

5 –Optimization: Opens the Optimization Step in the main working window. The
parameter optimization takes place in the main working area of the optimization
pane. Within this pane, the following major tasks can be performed:

Definition of the parameter-related optimization criterion (e.g., smooth-
ness, gradient constraints).

Determination of parameters as reference for the comparison with fol-
lowing optimization results.

Export of optimized parameters.

After performing these tasks, you can start the optimization.

Further information can be found in "Optimization" on page 46, in the tutorial (see
"Step 6: Optimization" on page 116), and in the online help.

6 – Visualization: Opens the Visualization Step in the main working window. In
this step you can visualize your data.

Further information can be found in " Visualization " on page 31, and in the online
help.

5.2.4 Log Window
The bottom part of the main window displays information about the current pro-
gram sequence, e.g. information about the optimization.
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Blue underlined words in the log window are links that open, e.g., the online help
or the user guide (a and b in the figure) or give access to sample projects (c - e in
the figure). In addition, the log files can be saved for analysis and error handling
reasons.

Fig. 5-2: Information in the log window (example; a: link to the online help, b: link
to the User Guide PDF)

Saving the logfile

1. Right-click in the log window and select Save Log to File from the context
menu.

The "Save Log file As" window opens.

2. Insert a file name and click Save.

The log file is saved.
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6 Tutorial: Working with ASCMO-MOCA

This chapter will help you with an example to familiarize yourself with the basic
functions of ETAS ASCMO-MOCA.

6.1 About this Tutorial
In this section you can find information about the structure of the tutorial and
about the requirements on the measurement data that are used for the para-
meter optimization.

6.1.1 Challenge in this Tutorial
An ECU often contains models for the calculation of signals, as the sensor-based
data logging is either too difficult or too expensive. A common use case is, for
example, the calculation of the engine torque. With ASCMO-MOCA you can set
up and calibrate a function and optimize the function's parameters based on the
measured sensor data. The goal of the optimizer is to minimize the root mean
square error "RMSE (Root Mean Squared Error)" on page 24 of the function's para-
meter. That means that the deviation between the function prediction and the
measured sensor data will be minimized.

The structure of the torque related function, that will be modeled step by step
during the tutorial, is displayed in "Step 5: Build Up the Function" on page 109.

6.1.2 Structure of the Tutorial
The subsequent tutorial is structured with the following working steps:

"Start ASCMO-MOCA" on page 80

This part of the tutorial describes how to start ASCMO-MOCA on your sys-
tem.

"Step 1: Data Import" on page 81

In this first step, the measurement data will first of all be loaded and the
channels will be associated with a function node.

"Step 2: Data Analysis" on page 93

For clearing up and evaluating the measuring data, at any time, you have
the possibility to visualize it after the import graphically for anytime.

"Step 4: Models" on page 99

In this step, you are able to link an existing Simulink model with and prepare
the mapping of the parameters, the inputs and outputs.

"Step 5: Build Up the Function" on page 109

After reading the measuring data and check the plausibility, you can start
to set up the function for the torque sensor that will be modeled during the
tutorial.

"Step 3: Parameters" on page 98
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This step allows you to check and possibly adapt the parameters. Only the
parameters will be visualized, which you have defined as reference after an
optimization "Step 6: Optimization" on page 116.

"Step 6: Optimization" on page 116

Before starting with the optimization you have to insert different settings,
which influence the optimization. After you have inserted these settings,
you can finally start the optimization.

"Step 7: Export" on page 118

In this step you will export the created and optimized parameters. The para-
meters can be exported as DCM file (*.dcm) and the project can be saved
for the runtime environment with limited functionality.

6.1.3 Requirements on Measurement Data
Basically, a simple rule needs to be considered for a successful parameter optim-
ization in ASCMO-MOCA: The quality of the function's parameter optimization res-
ult always depends on the quality of the measurement data. Or in other words: If
the parameters have been calibrated based on non space-filling or even wrong
data, the function prediction is of little use.

Importing the measurement file in ASCMO-MOCA requires a file with the following
properties:

Data format:
l Microsoft Excel (*.xls / *.xlsx)
l MDA Export (*.ascii)
l Comma Separated Values (*.csv / *.txt)
l Measurement Data Format (*.dat / *.mf4 / *.mdf / *.mdf3)

Outputs in columns

Names (and perhaps the units) have to be inserted in the first row (or in
the first and second row).

Note

The data used for parameterization do not necessarily have to be derived from
a physical experiment (e.g. test bench). They can also be for example a result
of a computer simulation.

6.1.4 Data for Modeling
The data used for the parameter optimization in this tutorial can be found in the
Torque_Data.xlsx Excel sheet in the <installation>\Example directory.

<installation> is the installation directory. By default, <installation> =
C:\Program Files\ETAS\ASCMO [[[Undefined variable ASCMOVar.-

prod_version2]]].

The measurement data from this file meets the already mentioned requirements
for a successful parameter optimization in ASCMO-MOCA:
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The experimental design for logging the sensor data (e.g. at a test bench)
corresponds to the DoE method, i. e. the measurements have been varied
independently and are space-filling.

The measured sensor data from the measurement file does not include
any absurd values (e.g. values ≤ 0 for torque).

6.2 Start ASCMO-MOCA
This part of the tutorial describes how to start ETAS ASCMO-MOCA on your sys-
tem.

Starting ASCMO-MOCA

1. Do one of the following:

i. In the ASCMO-DESKwindow, click theModel Calibration tile.

The start window of ASCMO-MOCA opens.

2. Click New in the menu panel on the left.

3. Click , , or

to open an empty project or to directly import
static or dynamic data.

If you clicked Empty Project, the empty main window of ASCMO-MOCA
opens. Now you can start with the measurement data import; see section
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"Step 1: Data Import" below.

6.3 Step 1: Data Import
In this first step, you will load the measurement data. When you import several
files, you can assign the channel names to project specific names, e.g. if the chan-
nel names are not identical.

Loading the measurement file

If you want to start a new project, you first of all have to load the required meas-
urement file for parametrization and optimization.

1. In the main working area, click the button Import Static Data.

2. In the file selection window, select the file Torque_Data.xlsx from the
<installation>\Example\Moca directory.

By default, <installation> is C:\Program Files\ETAS\ASCMO

[[[Undefined variable ASCMOVar.prod_version2]]].

3. ClickOpen.

If the import file contains several worksheets, the Sheetswindow opens.
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4. In the Sheetswindow, select the worksheet you want to import (for this
tutorial: Torque_Data), then clickOK.

The ASCMO Data Importwindow (see ) opens.

The Data Preview table shows all data in the table. In the Available Chan-
nels field, you can determine which channels you want to import.

6.3.1 Checking the Plausibility of the Measurement Data
To check the measurement data again prior to the data import, you can display
the measurement data, and you can check the relevance of the inputs.

To display measurement data prior to the import

1.

In the Available Channels field, select one or more measuring data chan-
nels.
You can use the standard CTRL/SHIFT selection functions in the table, or
click and hold LMB and drag the cursor over the cells/rows you want to
select.

2. Do one of the following:
l Click Plot Selected.
l Select Extras > Plot Selected.

A window opens that displays one of the plots listed below, depending on
the number of selected channels.

3. Check the plots for outliers or other unusual/implausible data.

1 channel:measured data against number of measurement - e.g., Speed
against measurement number.
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2 channels: data of one column against data of the other - e.g., Rel_air-
mass against Speed.

3 channels: data of the third column against the plane set up by the other
two - e.g., Torque_Meas against the Speed-Rel_airmass plane.
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4 or more channels: a series of scatter plots.

To check the relevance of the inputs

See "Checking the Relevance of the Inputs" on page 20 for more information on
how the relevance is determined.
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1. In the Available Channels field of the ASCMO Data Importwindow, select
the input measuring data channels.

Note

At least one channel must remain unselected. If you select all channels,
you cannot check the relevance of the inputs.

2. Click Import or double-click a channel.

The selected channels are added to the Import list.

3. Select Extras > Find Relevant Channels.

The Select Inputs for Channel Relevancewindow opens.

4. In that window, select at least two input channels and clickOK.

5. The Select Outputs for Relevancewindow opens.

6. In that window, select one or more output channels and clickOK.

The "Relevance of Inputs" window opens. It visualizes the influence of the
inputs on the outputs.

7. Click Show Table to display the results as a data table in the Relevance of
Inputs Tablewindow.

8. If desired, refine your import selections based on the results.
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6.3.2 Saving and Loading a Configuration
A configuration file (*.ini) may contain a special assignment of individual meas-
urement data columns to the function variables.

Saving and loading a configuration

1. In the ASCMO Data Importwindow, select File > Save Channel Config
(*.ini).

2. In the file selection window, enter the name of the file under which the cur-
rent configuration should be saved.

3. To load a previously saved configuration file, select File > Load Channel
Config (*.ini).

6.3.3 Importing Measurement Data
Now the data can be imported.

Importing the measurement data

1. In the ASCMO Data Importwindow, select all channels in the Available
Channels field.
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2. Click Import →.

The channels are added to the Import list.

3. Click Import at the bottom right.

The data is imported in the current ASCMO-MOCA project. The content of
the imported file is displayed in the Data tab.

6.3.4 Mapping Measurement Channels to Variables
In the next step, the channels of the imported measurement file have to be
assigned to a variable (node), which will be used in the functions later.

Note

If the measurement file's structure meets the requirements (see "Require-
ments on Measurement Data" on page 79) for the data import , every channel is
automatically assigned to the corresponding variable.

Because ASCMO-MOCA automatically performs the assignment, you can pro-
ceed with the analysis of the imported measurement data (see "Step 2: Data Ana-
lysis" on page 93).

Changing the variable name

If you want to use a different variable name (Name in Project column) in your
functions, you can change the name in the Data Step,Channel Name Mapping
table. To do so, proceed as follows:

1. In the Name in Project column, click on the variable whose name you want
to change.

2. Enter the new variable name.
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3. Press Enter.

The new variable name is applied.

Deleting a mapping

If you do not require certain channels in your measuring data for the parameter,
you can delete the mapping in the Data pane,Channel Name Mapping table.

1. In the Name in Project column, select the desired variable.

2. Click Delete.

The variable is deleted from theChannel Name Mapping table.

6.3.5 Working in the Data Step of ASCMO-MOCA

ASCMO-MOCA supports multiple datasets for training and test data, shown as
multiple tabs in the data pane. All training datasets together are used for the
optimization, while the test datasets are used for evaluation and prediction pur-
poses.

A weight per dataset can be given, which controls the impact of this dataset on
the optimization.

Different datasets can have different column names; name mapping is then used
to correctly attach the different datasets.

The first import is always used as the first training dataset. When you import
another file, you can choose to use this dataset as an additional training dataset
or as test dataset or as a replacement. To get the RMSE for a test data set, Ana-
lysis > Residual Analysis > Test Data > * can be used.

Loading multiple data sets

If you want to load multiple data sets, proceed as follows:
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1. Click Import Data.

2. In the file selection window, enter or select path and name of the file you
want to import.

3. ClickOpen.

The ASCMO Data Import - <file name> window opens.

4. In that window, select the input channels as described in "Loading the
measurement file" on page 81.

5. Click Import.

The selected file is imported.

Renaming a data set

1. Go to the tab of the data set you want to rename.

2. Right-click the tab and select Rename data set from the context menu.

3. In the Renamewindow, enter the new name, then clickOK.

Deleting a data set

1. Go to the tab of the data set you want to delete.

2. Click Delete Dataset.

A confirmation window opens.

3. In the confirmation window, click Delete.

The selected data set is deleted from the project.

6.3.5.1 Data Point Weights
With theWeight column, the optimization weight for a data point can be set.
Data rows can be set inactive by setting the value to zero. Inactive rows are
ignored for the RMSE calculation and optimization. The default is one, and higher
values show the optimizer that the respective points are more important, i.e. a
stronger emphasis to meet the optimization criterion for this data point. The
weight influences the optimization but is not reflected in the displayed RMSE.

Multiple rows can be selected with the <SHIFT> and <CTRL> key and left mouse
button clicking. Then the weight for multiple rows can be set with theWeight but-
ton.

Another possibility to set the weight of data points is available in the scatter plot
window, opened with Analysis > Scatter Plot > *. After marking some data
points in a scatter plot, you can use the Extras > Set Marked Points Weight
menu option to set the weight for the marked data.
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Setting the weights of selected data points

1. To set the weights of data points via theWeight button, proceed as fol-
lows:

i. Select one or more rows.

ii. ClickWeight.

iii. In the Data Weight Formulawindow, enter the weight and select if you
want to set it for the data points inside or outside the current selection.

iv. ClickOK.

The weight is assigned.

2. To set the weight of an individual row, proceed as follows:

i. In theWeight column, double-click in the row you want to edit.

ii. Enter the number you want to assign.

Adjusting the weights of the entire data set

To adjust the weights of the entire data set, proceed as follows:

Note

The data set weight has no effect if there is just one data set.

1. In theWeight field, enter a value.

A value of 0 disables the data set. For this tutorial, enter the value 8.

2. To see the effect of the data set weight, select Analysis > Data Table >
Training Data or Test Data or Training and Test Data.

The following window opens.
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All values in theWeight column have been multiplied with the entered
value in theWeight of <Dataset_name> field. A row weight of 5 and a
data set weight of 8 mean that this row has an absolute weight 40.

6.3.5.2 Managing Data in a Dataset
ASCMO-MOCA offers various possibilities to edit, filter and sort the data in a data-
set:

Editing data points

To set a value in a particular column and row, proceed as follows:

1. In the column you want to edit, click in the row you want to edit.

2. Enter the number you want to assign.

Removing NaN values

If your imported data contains non-numeric values, you can automatically delete
the affected rows in all data sets. Proceed as follows:

1. To delete the rows with NaN values, click Remove NaN.

Filtering data

Note

The filter affects all data sets and only the views, not the optimization. To
ignore data for the optimization, set the data weight to 0. For more information,
see the MOCA Help.

1. Select Analysis > Filter Data.

The Filter Datawindow opens. The Standard Filter allows to filter single
columns, the Formula Filter area allows a more complex filter.
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2. In the Standard Filter area, proceed as follows:

i. In the empty dropdown, enter or select a column name.

A filter for the selected column is created.

ii. In the input fields at both ends of the filter line, enter lower and upper
limit.

A lower (upper) value of -Inf (Inf) means no lower (upper) limit.

iii. In the dropdown lists, select the operators (< or ≤).

iv. Click the Remove this filter button to delete the filter.

3. In the Formula Filter area, proceed as follows:

i. In the dropdown list, select the operator (OR or AND) that will connect
standard filters and formula filters.

The input field for formula filters becomes active.

ii. In the input field, enter the formula condition you want to use.

The formula must follow the MATLAB syntax. Names of inputs and
nodes must be included in %. You can drag names of inputs and nodes
from the Input and Node Names area to the input field.

Example formula condition: %Speed% > 2000 & (%Ignition% < 5
| %Rel_Airmass% == 2)

For further information about formula conditions, see 6.7 "Step 5: Build
Up the Function" on page 109.

4. ClickOK or Apply.

All rows that do not match the filter criteria are hidden.
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Deleting a data point

1. Select a value in one or more rows.

2. Click the Delete button in the Rows area.

A confirmation window opens.

3. In the confirmation window, click Delete.

The selected rows are deleted.

Deleting an input column

1. Select a value in one or more columns.

2. Click the Delete button in theColumns area.

A confirmation window opens.

3. In the confirmation window, click Delete.

The selected columns are deleted.

6.4 Step 2: Data Analysis
For clearing up and evaluating the measuring data, you have the possibility to
visualize it after the import graphically for anytime.

During the analysis, particular the following points should be considered.

Have all parameters been varied according to the experiment plan and did
the measured system remain in the operating mode intended for this pur-
pose?

Do the output variables fall in physically meaningful ranges?

Are there any outliers included, which have to be removed, if appropriate?

Visualizing measurement data in a scatter plot

1. Select Analysis > Scatter Plot > Training Data/Test Data/Training and
Test Data > Data/Function Nodes.

The Data and - if your project contains function nodes – Function Nodes
windows open. Only the Datawindow is used for the current task.
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The bottom-left plot (Speed over Rel_Airmass) shows the space-filling
variation of the data in the experimental plan.

Changing the axis pairs

Since the current view does not show the dependence of the relevant meas-
urement data, you must adjust the axis pairs. The selection of the displayed axes
takes place directly in the plot window.

1. In the Datawindow of Scatter Plot, select View > Select Axes.

The "Select Axes" window opens.

2. Go to theMatrix tab.

3. In theMatrix tab, select the axis pairs shown in the following figure.

ASCMO-MOCA V5.13 | User Guide



6 Tutorial: Working with ASCMO-MOCA | 95

In the List tab, you have an alternate representation of the selection of the
axes pairs that are to be visualized.

4. Do one of the following:
l Click Apply.
l Click OK.

The visualized axes in the scatter plot will be adjusted. The Select Axes
window remains open.

Deleting an outlier

You can now use the scatter plots to remove outliers.

1. Search the plots for outliers.

In this tutorial, use the top-left point in the Torque_Meas over Speed plot,
with Torque_Meas > 300.

2. Click the Mouse selection in Plot with Rectangle button.

3. Click in the plot and draw a rectangle around the outlier.
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The selected points are colored in all scatter plots.

4. Right-click the frame of the rectangle and selectMark Point from the con-
text menu.

The marked points are highlighted with a red circle.

5. Select Extras > Delete Marked Points.

The outlier is deleted from the measurement data.

Displaying the measurement data range

After deleting the outlier from the measurement data, you can check whether the
values of the measurement file are within a plausible range.

ASCMO-MOCA V5.13 | User Guide



6 Tutorial: Working with ASCMO-MOCA | 97

1. In the main window, select Analysis > Show Data Min/Max.

TheMin/Max Data & Nodeswindow opens.

After importing and reviewing the measurement data, you can start to add
nodes to the function. To do so, select the Functionworking step in the
navigation (see "Elements of the ASCMO-MOCA User Interface " on
page 73). The respective elements in the main working window will appear,
where you can save, delete and edit the function "Step 5: Build Up the
Function" on page 109).
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6.5 Step 3: Parameters

This step allows you to check and possibly adapt the parameters. Only the ref-
erence parameters will be visualized, but not the optimized parameters. You can
set the optimized parameters as (new) reference in the Optimization step.

In addition, you can display the reference and the current map during the optim-
ization and visualize the data points in maps and curves.

Also you have the possibility to fix individual grid points and to lock them for the
optimization.

Further information about how to create and edit a parameter is given in "Step 5:
Build Up the Function" on page 109.

Note

In this tutorial, the parameters are already defined, so you can skip this step
and continue with the optimization (see "Step 6: Optimization" on page 116).

NOTICE
If you extend the data range and limits of the function parameters beyond the
valid range of your system (e.g., a test bench), the system can become over-
loaded and damaged, when using the exported parameters in the system.

Always ensure that the limits and ranges in ASCMO-MOCA match the limits and
ranges of your system before exporting the parameters.

If you want to perform a specific calibration and optimization task, these values
are required knowledge.
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6.6 Step 4: Models

In this step, you can link an existing Simulink® model with ASCMO-MOCA and pre-
pare the mapping of the parameters, the inputs and outputs.

Note

You do not have to embed a model to ASCMO-MOCA as a part of this tutorial.
Therefore, you can skip this step in the navigation and start to build the func-
tion "Step 5: Build Up the Function" on page 109.

This step requires a Simulink® installation. By default, ASCMO-MOCA will use the
MATLAB® and Simulink® version most recently installed on your system.

Selecting a Simulink® version

1. In the main window, select File > Options.

TheOptionswindow opens.

2. In the Simulink Version dropdown, select the version you want to use.

3. ClickOK to apply your settings.

6.6.1 Adding A Simulink® Model and Scripts
You can add a Simulink model, which can be selected as node in "Step 5: Build Up
the Function" on page 109. To add a Simulink model, proceed as follows:

Adding a Simulink® model and scripts

1. In the main working area, click on Add Model and selectConnect to Sim-
ulink Model.

A new line is added to the model list; additional options are displayed in the
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lower part of the Model Step.

2. In the Simulink Model field, enter or select (via the button) path and

name of the Simulink model to be optimized.

This can be an *.mdl (before R2012a) or *.slx (from R2012a) Simulink
model.

3. Press <ENTER> or click in another field.

A warning opens if the Simulink model does not exist. Proceed as follows.

i. Confirm the warning withOK.

ii. Correct path and/or file name of the Simulink model.

4. If desired, enter or select (via the button) path and name of an execut-

able M-script in the Pre Load Script field.

This Init script is optional and may contain a pre-calibration for the Simulink
model. The pre-calibration is expected as a MATLAB workspace variable
that will be assigned in the Parameters Mapping table.

5. If desired, enter or select (via the button) path and name of another

executable M-script in the Post Load Script field.

This script is optional.

Note

You can use %ProjectPath% as the location. This is then automatically
replaced by the current location of the ASCMO-MOCA project.

6.6.2 Mapping Simulink® Parameters
In the Parameters Mapping area, project-related maps/curves and scalars can
be mapped to the parameters from the Simulink model.

ASCMO-MOCA expects the parameters to be calibrated as MATLAB® workspace
variables. This could for example be the following Simulink map:
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You can map project-related parameters and Simulink parameters either auto-
matically (see "Scanning the Simulink® model and mapping parameters" below)
or manually (see "Mapping parameters manually" on the next page).

Scanning the Simulink® model and mapping parameters

To automatically scan the Simulink model for possible parameters, proceed as fol-
lows.

1. In the main window, Parameters Mapping area, click Scan Model.

The block masks of lookup tables and other blocks are scanned for variable
names. The results are then presented in the "Scan Model <model_name>
for Parameter Mapping" window.

2. Activate/deactivate the Scalars,Matrix,Curves,Maps and/or Group Axes
checkboxes to show/hide parameters of the respective types.

3. In the Filter field, enter the string by which you want to filter the list, then
press <ENTER>.

Note

The filter is not caps-sensitive. You cannot use wildcards.

Only parameters whose Simulink names or paths contain the search string
are displayed.

4. In theCreate Mapping column, activate the checkboxes in all rows you
want to map.

5. Click Add Mappings to add the selected mappings to the Parameters Map-
ping list.
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With Add Mappings, existing content in the Parameters Mapping list is
kept. If an existing row is selected again, this selection is ignored and a
message is issued in the log window.

Replace Mappings removes existing content in the Parameters Mapping
list.

Mapping parameters manually

1. In the Parameters Mapping area,MOCA Parameter column, select a para-
meter from the dropdown list.

You can also create a new parameter with theCreate Parameter button or
import a DCM file with the Import Parameter button.

2. In the Table Data Simulink and Breakpoints <n> Simulink columns, enter
the variable names from the block mask.

Or - as an alternative -

3. Proceed as follows.

i. Click Edit Mapping.

TheMapping of <parameter> window opens. The init script is
executed first and the model is loaded. The existing MATLAB workspace
variables are displayed. ASCMO-MOCA automatically performs a name
search.

ii. In the Field column, select the MATLAB workspace variable that
describes the parameter value or table data.

iii. In the Breakpoint <n> columns, select MATLAB workspace variables
used for the table axes.

iv. ClickOK to accept your settings and close theMapping of <para-
meter> window.

The Table Data Simulink and Breakpoint <n> Simulink columns in the
Parameters Mapping area are updated according to your selections.
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6.6.3 Mapping Simulink® Inputs
In the Simulink Inputs Mapping area, imported data columns or nodes from the
ASCMO-MOCA project can be mapped to the Simulink model inputs.

Scanning the Simulink® model and mapping inputs

To automatically scan the Simulink model for inputs, proceed as follows:

1. In the Simulink Inputs Mapping area, click Scan Model.

The model is scanned for Inport and From Workspace blocks. The results
are then presented in the "Scan Model <model_name> for Inputs" window.

Fig. 6-1: "Scan Model <model_name> for Inputs" window

2. If necessary, enter the dimension and qualifiers manually.

Consider, for example, the following input ports, which expect a bus and a
vector.

ASCMO-MOCA automatically tries to identify such a bus or vector signal,
by following the signal flow in Simulink. If this fails, you have to manually
enter the type, dimension and qualifier.

3. In theCreate Mapping column, activate the checkboxes in all rows you
want to map.

4. Click Add Mappings to add the selected mappings to the Simulink Inputs
Mapping list.

With Add Mappings, existing content in the Simulink Inputs Mapping list
is kept. If an existing row is selected again, this selection is ignored and a
message is issued in the log window.

Replace Mappings removes existing content in the Simulink Inputs Map-
ping list.

After clicking Add/Replace Mappings, the Simulink Inputs Mapping table
is filled.
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The notation Speed | In(1) means that the first Simulink Input data
column is passed as Speed.

A list of possible notations is given in the online help.

6.6.4 Mapping Simulink® Outputs
In the Simulink Outputs Mapping area, the simulation outputs are made available
to ASCMO-MOCA. Outport and ToWorkspace blocks are supported.

Scanning the Simulink® model and mapping outputs

1. In the Simulink Outputs Mapping area, click Scan Model.

The model is scanned for Outport and ToWorkspace blocks. The results are
then presented in the "Scan Model <model_name> for Outputs" window.

Fig. 6-2: "Scan Model <model_name> for Outputs" window

2. If necessary, enter the dimension and qualifiers manually.

3. In theCreate Mapping column, activate the checkboxes in all rows you
want to map.

4. Click Add Mappings to add the selected mappings to the Simulink Out-
puts Mapping list.

With Add Mappings, existing content in the Simulink Outputs Mapping
list is kept. If an existing row is selected again, this selection is ignored and
a message is issued in the log window.

Replace Mappings removes existing content in the Simulink Outputs
Mapping list.

Example
Torque_PredictSL | Out(1) makes the Simulink output available for optim-
ization under the name Torque_PredictSL.
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A list of possible notations is given in the online help.

6.6.5 Validating and Using the Simulink®Model

Note

Running a Simulink® model is only possible if a suitable Simulink® version with
corresponding license is available on your system.

After mapping parameters, inputs and outputs, perform the following steps:

6.6.5.1 Validating a Simulink®Model
Validating a Simulink® Model

1. In the lower section of the main working area, click Validate.

The validation is performed.

During validation, the following steps are executed:

Start the (optional) init script.

Add the model path to the MATLAB search path.

Open the Simulink model.

Start the (optional) post-load script.

Check if all parameters are available as workspace variables.

Replace the in/out ports in accordance to the In/Out mapping.

Start a simulation with a subset size of the data.

Read the output values.

Possible errors are reported. If the test is successful, a success message is dis-
played. The Simulink model is now ready for optimization.

Before you can use a model for the optimization, you need to make it available in
the function.

Using a Simulink® model

Before you can use a model for the optimization, you need to make it available in
the function. Proceed as follows:

1. In the navigation pane, click Function.

The Function pane opens.

2. Add a new node (see the online help for details).

The Simulink models are available in the Nodes area of the Edit Nodewin-
dow.
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3. Insert the model in the expression.

The expression is set to %Torque%(Speed, Rel_Airmass,

Ignition). In addition, the name Torque_mdl is entered in the Node
Name field.

4. If desired, validate the node.

5. ClickOK.

The node for the model is added to theMain Function Nodes table.

For the model output, another node named Torque_mdl.torque_Sim-

ulink_Model is created.

6. If desired, create more function nodes.

See "Step 5: Build Up the Function" on page 109 for more information.

If you are using a Simulink model with multiple outputs, one function node is cre-
ated for each model output. These nodes can be used in optimization criteria and
expressions.

The default notation used in theMain Function Nodes table is marked in Fig. 6-3.
The notation used in previous versions of ASCMO-MOCA (nodes Torque*_5.0
in Fig. 6-3) remains valid.
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Fig. 6-3: Notation for a Simulink model with multiple outputs

Note

An implementation of ASCMO-MOCA using a Simulink® model with several out-
puts can be found in the example project Torque_Exten-
dedSimulinkExample.moca in <installation>\Example\Moca directory.
By default, <installation> = C:\Program Files\ETAS\ASCMO

[[[Undefined variable ASCMOVar.prod_version2]]].

Optimizing a Simulink® model

1. In the navigation pane, clickOptimization.

2. UnderOptimization Criteria, select the optimization criteria that are
based on the outputs.
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3. Click theOptimize button.

The optimization of the Simulink model is started. Information about the
optimization can be found in the Log window (for example on iterations,
RMSE). The resulting RMSE is shown below each optimization criterion.
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6.7 Step 5: Build Up the Function

After reading the measuring data and checking the plausibility, you can start to
set up the function for the torque sensor that will be modeled during the tutorial.
The available operators are described in section " Mathematical Operators for
Function Nodes" on page 39.

NOTICE
If you extend the data range and limits of the function parameters beyond the
valid range of your system (e.g., a test bench), the system can become over-
loaded and damaged, when using the exported parameters in the system.

Always ensure that the limits and ranges in ASCMO-MOCA match the limits and
ranges of your system before exporting the parameters.

If you want to perform a specific calibration and optimization task, these values
are required knowledge.

6.7.1 Modeling the Function
In the tutorial you will build the following function of the physical "engine torque"
model.

Fig. 6-4: Structure of the function to be modeled
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Note

Functions are always set up from left to right.

The model function shown in "Structure of the function to be modeled" on the
previous page contains the following inputs:

1 - Speed

2 - Rel_Airmass

3 - Ignition

In addition to the inputs, you have imported the measured model output
Torque_Meas in "Step 1: Data Import" on page 81. These values will be used as
reference for the optimization, for minimizing the deviation between the meas-
ured values and the function prediction TorquePredict.

Adding the first node

To insert the first node trqOpt, proceed as follows.

1. Do one of the following:
l In theMain Function Nodes table, click the New entry.
l Click Insert.

The "Edit Node" window opens. All data channels you imported are listed in
the Data area.

2. In the Node Name field, enter the name trqOpt.

3. If desired, enter a unit.

The unit has no influence on the calibration of the parameter and is only
visualized for support.

4. Create a parameter MapOptTorque as described in "Creating a new para-
meter" on the next page.
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5. Specify the expression for the function node.

i. In the Parameter area, select the parameter MapOptTorque.

ii. Click the button.

The parameter is added to the Expression field.

iii. Click Validate to check the validity of the new node.

6. ClickOK to add the node and close the Edit Nodewindow.

The node is displayed in the first row of the Function Nodes table.

Creating a new parameter

To create the MapOptTorque parameter, proceed as follows.

1. In the Edit Notewindow, click theCreate button below the Parameter
area.

TheCreate Parameterwindow opens.

2. Enter the parameter information.

For MapOptTorque, use the following values:

Parameter Name: MapOptTorque

Parameter Type: Map

Value Bounds: 0 - 500

Input 1: Speed

Input 2: Rel_Airmass
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Breakpoints X: Begin/End; Begin = 500; End = 6000; Count = 6

Breakpoints Y: Begin/End; Begin = 10; End = 90; Count = 6

Extrapolation: Clip

Note

If you click Use Range, the values range of the X and Y axes are auto-
matically set to the minimal and maximal value of the channel.

3. ClickOK.

The parameter is created. It appears in the Parameter area.

Next, you create and set up the node ignOpt.

Adding and editing the node ignOpt

To add and edit the second node ignOpt, proceed as follows:

1. Open the Edit Nodewindow.

2. Enter the node name ignOpt.

For this node you need a parameter MapOptIgnition.

3. Create the parameter MapOptIgnition (see "Creating a new parameter"
on the previous page) with the following values:

Parameter Name: MapOptIgnition

Parameter Type: Map

Value Bounds: 0 - 60

Input 1: Speed

Input 2: Rel_Airmass

Breakpoints X: Begin/End; Begin = 500; End = 6000; Count = 6

Breakpoints Y: Begin/End; Begin = 10; End = 90; Count = 6

Extrapolation: Clip

4. Specify the following expression for the function node:

5. Check the validity of the new node.

6. ClickOK to add the node and close the Edit Nodewindow.

Next, you create and set up the node deltaSpark.

Adding and editing the node deltaSpark

To add and edit the third node deltaSpark, proceed as follows:
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1. Open the Edit Nodewindow.

2. Enter the node name deltaSpark.

For this node you need the node ignOpt and the input Ignition.

3. In the Nodes area, select ignOpt and click .

The ignOpt node is added to the Expression field.

4. Click to add a subtraction operator.

5. In the Data area, select Ignition and click on .

The Ignition channel is added to the Expression field.

6. Make sure that the expression looks as follows:

7. Check the validity of the new node.

8. ClickOK to add the node and close the Edit Nodewindow.

Next, you create and set up the node etaSpark.

Adding and editing the node etaSpark

To add and edit the fourth node etaSpark, proceed as follows:

1. Open the Edit Nodewindow.

2. Enter the node name etaSpark.

For this node you need a parameter CurveEtaDeltaSpark.

3. Create the parameter CurveEtaDeltaSpark (see "Creating a new para-
meter" on page 111) with the following values:

Parameter Name: CurveEtaDeltaSpark

Parameter Type: Curve

Value Bounds: 0 - 1

Input 1: deltaSpark

Breakpoints X: Begin/End; Begin = -10; End = 55; Count = 10

Extrapolation: Clip

4. Specify the following expression for the function node:

5. Check the validity of the new node.

6. ClickOK to add the node and close the Edit Nodewindow.

Next, you create and set up the node product.
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Adding and editing the node product

To add and edit the fifth node product, proceed as follows:

1. Open the Edit Nodewindow.

2. Enter the node name product.

For this node you need the nodes trqOpt and etaSpark.

3. In the Node area, select trqOpt and click .

The trqOpt node is added to the Expression field.

4. Click to add a multiplication operator.

5. Add the etaSpark node to the expression.

6. Make sure that the expression looks as follows:

7. Check the validity of the new node.

8. ClickOK to add the node and close the Edit Nodewindow.

Next, you create and set up the node dragTorque.

Adding and editing the node dragTorque

To add and edit the sixth node dragTorque, proceed as follows:

1. Open the Edit Nodewindow.

2. Enter the node name dragTorque.

For this node you need a parameter MapDragTorque.

3. Create the parameter MapDragTorque (see "Creating a new parameter"
on page 111) with the following values:

Parameter Name: MapDragTorque

Parameter Type: Map

Value Bounds: 0 - 100

Input 1: Speed

Input 2: Rel_Airmass

Breakpoints X: Begin/End; Begin = 500; End = 6000; Count = 6

Breakpoints Y: Begin/End; Begin = 10; End = 90; Count = 6

Extrapolation: Clip

4. Specify the following expression for the function node:

ASCMO-MOCA V5.13 | User Guide



6 Tutorial: Working with ASCMO-MOCA | 115

5. Check the validity of the new node.

6. ClickOK to add the node and close the Edit Nodewindow.

Next, you create and set up the node TorquePredict.

Adding and editing the node TorquePredict

To add and edit the last node TorquePredict, proceed as follows:

1. Open the Edit Nodewindow.

2. Enter the node name TorquePredict.

For this node you need the nodes product and dragTorque.

3. In the Node area, select product and click .

The product node is added to the Expression field.

4. Add a subtraction operator.

5. Add the dragTorque node to the expression.

6. Make sure that the expression looks as follows:

7. Check the validity of the new node.

8. ClickOK to add the node and close the Edit Nodewindow.

After adding the node TorquePredict, the creation of the function to be
optimized as a representation of the physical torque model is finished. The
"Function Nodes" table should look like this:
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Note

If you activate the Edit Mode option in the main working window, you can
change the elements of the function directly in the "Function Nodes"
table. The names of data, parameters and nodes are marked with %.

In the next step "Step 3: Parameters" on page 98 you have the possibility
to check and edit the created parameters, if appropriate.

6.8 Step 6: Optimization

Before you start optimizing, you need to choose an optimization algorithm. To
help you choose the best algorithm for your purpose, see "Optimization
Algorithms" on page 47.

After you choose an algorithm, clickOptimizer Options Configure to cus-
tomize the options. For a description of the options available for each algorithm,
see "Optimizer Options" on page 50.

Note

The above listed criteria and limits have to be adapted for the specific problem,
such that a satisfactory minimal deviation ( see "Variables RMSE and R2" on
page 24) between the measured data and the function prediction can be
reached by optimization.

In theOptimization Options area, you specify several parameters, see 6.8 "Step
6: Optimization" above.
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In theOptimization Criteria area, you specify the optimization target. Select a
function node in the first dropdown and a data channel (or '0') in the second drop-
down. The optimizer then tries to find a set of parameter values that minimizes
the quadratic deviation of these two quantities.

The Local Constraints area is not used in this tutorial to keep the example in the
tutorial simple. Depending on the optimization problem, these constraints can be
used to guide the optimization in a specific direction.

Preparing the optimization

1. In theOptimization Options area, do the following:

i. In the Number of Iterations field, enter a number of 40 iterations.

ii. Increase the number ofMultistart (Optimizer Options Configure)
to prevent the optimizer from getting stuck in a local minimum.

2. In theOptimization Criteria area, do the following:

i. From the first drop-down list, select the function output TorquePredict.

ii. From the second drop-down list, select the imported data channel
Torque_Meas.

The flat parameters results in a high RMSE (see "Variables RMSE and
R2" on page 24). After the first optimization, the RMSE will be sig-
nificantly reduced.

You have the possibility to define a sum of such optimization criteria using
the Add a new Optimization criterion button.

Performing the optimization

NOTICE
Damage due to wrong calibration data

Wrong usage of calibrations derived from ASCMO-MOCA model can lead to
engine or test bench damage.

Compare measured data and model created data with Residual Analysis fea-
ture after the optimization or before exporting at the latest. Feature is access-
ible via Analysis > Residual Analysis > Training and Test Data > Absolute Error
Analysis.

See "Performing the optimization" above, export options in "Parameters" Step or
"Optimization" Step, and 6.9 "Step 7: Export" on the next page.

Once you have finished the preparations, start the optimization.
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1. ClickOptimize.

The optimizer starts optimizing the parameters. Information about the
optimization can be found in the log window (e.g., iterations, RMSE). The
resulting RMSE is displayed below the optimization criterion. The visu-
alization of the maps is adjusted accordingly.

The optimization in this tutorial is now completed. Some optional activities
in theOptimization step are described in the online help, section "Instruc-
tions (Optimization Step)".

In the following step (see "Step 7: Export" below), the optimized parameters will
be exported for further processing.

6.9 Step 7: Export

NOTICE
Damage due to wrong calibration data

Wrong usage of calibrations derived from ASCMO-MOCA model can lead to
engine or test bench damage.

Compare measured data and model created data with Residual Analysis fea-
ture after the optimization or before exporting at the latest. Feature is access-
ible via Analysis > Residual Analysis > Training and Test Data > Absolute Error
Analysis.
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See "Performing the optimization" on page 117, export options in "Parameters"
Step or "Optimization" Step, and 6.9 "Step 7: Export" on the previous page.

In this step, you will export the created and optimized parameters. The para-
meters can be exported in several file formats, and the project can be saved for
the runtime environment ASCMO-MOCA Runtime with limited functionality.

Exporting the parameters

1. In theOptimizationwindow, click the Export button.

The Export Parameterswindow opens.

2. In that window, enter or select path and name of the export file.

3. In the Save as type dropdown-list, select the export format.

Available formats
l DCM files (*.dcm)
l INCA comma-separated Values (*.csv)
l Excel (*.xls, *.xlsx, *.xlsm)
l Calibration data files (*.cdfx)
l M-script (*.m)

4. Click Save.

The parameters will be exported to a file in the selected format.

Exporting the project for ASCMO-MOCA Runtime

When you export a project to ASCMO-MOCA Runtime, the project gets encryp-
ted, and the function in the project cannot be seen or edited.

1. In the main menu, select File > Export to MOCA-Runtime.

The Export to MOCA-Runtimewindow opens.

2. Activate Show Sequence if you want to show the optimization sequence
in the exported project.

With that, you can see and edit the sequence in ASCMO-MOCA Runtime.
The sequence is hidden if Show Sequence remains deactivated.

3. Activate Allow opening in MATLAB (MOCA-Runtime p-Code) to allow the
exported project to be opened in the p-Code version of ASCMO-MOCA
Runtime.

If you activate Allow opening in MATLAB (MOCA Runtime p-Code), the
exported project gets encrypted with another key. ASCMO-MOCA Runtime
p-Code cannot open exported projects without this setting. Such projects
can only be opened with the standalone version of ASCMO-MOCA
Runtime.

4. Click Export to continue.

The Export MOCA project to MOCA-Runtimewindow opens. The
*.moca_runtime format is preselected; it is mandatory.
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5. Enter the file name and the file directory.

6. Click Save.

The project is saved for ASCMO-MOCA Runtime.
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7 Contact Information

Technical Support

For details of your local sales office as well as your local
technical support team and product hotlines, take a look at
the ETAS website:

www.etas.com/hotlines

ETAS offers trainings for its products:

www.etas.com/academy

ETAS Headquarters
ETAS GmbH

Borsigstraße 24 Phone: +49 711 3423-0

70469 Stuttgart Fax: +49 711 3423-2106

Germany Internet: www.etas.com
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Glossary

F
Function

A function is the set of all elements required to represent the physical model.

P
Project

Creation and optimization of functions and parameters occur in the context of a pro-
ject. This project can be saved and loaded. One project at a time can be opned and
edited in one instance of ASCMO-MOCA.

R
Residual

The residual is the discrepancy between measured data and function calculation.
ASCMO-MOCA distinguishes between relative, absolute, and studentized error.

Residuum

The residual is the discrepancy between measured data and function calculation.
ASCMO-MOCA distinguishes between relative, absolute, and studentized error.

RMSE

The root mean square error (RMSE) is a measure of the deviation of the predictions of a
model from the actual values of the modeled object. The single deviation is called
residuum.

Root Mean Square Error

The root mean square error (RMSE) is a measure of the deviation of the predictions of a
model from the actual values of the modeled object. The single deviation is called
residuum.

Roughness

Roughness describes the change in slope from one grid point of a curve, pap, or cube to
the next.

S
Scalar

A scalar is a 0-dimentional calibration parameter.

System Constant

A system constant is a container for an element that cannot be changed. The coun-
terpart o a system constant is a variable.
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T
Tolerance

Generally, a tolerance is a threshold which, if crossed, stops the iterations of a solver.
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ASCMO model 37

C
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RMSE 24
Compressed model 29
Concept 17

assessment of input data 19
parameter optimization 26

Configuration file
load 86
save 86

Contact Information 121
Correlation

of parameters 61-62

D
Data

check plausibility 82
check relevance 20,84
filter 91
remove NaN 91

Data analysis 93
Data point

delete 93
edit 91
set weight 90
weight 89

Data quality
assessment 20
improvement 20

Data set See also Measurement data
delete 89
load multiple 88
multiple 88
rename 89
weight 90

E
Error Analysis

absolute 21
data 20
function node 20
relative 21

Residual Analysis 21
studentized 21

ETAS
Contact Information 121

F
Fields of application 18

ASCMO MOCA 18
ASCMO MOCA Runtime 18

Filter data 91
FMU model 36
Function

add node 110
create 109
mathematical operators 39
structure 109

Function evaluation
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RMSE 25

Function variable
change name 87
delete mapping 88
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glossary 122

I
Import 81

display data 82
load configuration 86
measurement data 81
save configuration 86
start 86

Input data
assessment 19
improvement 19

Inputs
relevance 20,84

Installation 10
directories 14
files 14
license agreement 11
path specification 11
preparation 10
start 10
uninstall MOCA 16
user privileges 10
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Licensing 15
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save 77

M
Matlab/Simulink

select version 99
Measurement data See also Data set

delete channel 93
delete mapping to variable 88
import 86
map channel to variable 87
plausibility check 82
requirements 79

Measurement file
format 79
load 81

Methods 17
MOCA

start 80
uninstall 16

MOCA Runtime
Export to 119
Export to p-Code version 119

Models 36
add Simulink model 99
ASCET 36
ASCMO-DYNAMIC 37
ASCMO-STATIC 37
FMU 36
map parameters 100-101
map Simulink inputs 103
map Simulink outputs 104
Simulink 99
TSim Plugin 37
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Nodes

add 110
Mathematical operators 39
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Optimization 46,60,116

Parameter 26
Simulink model 107
with sequence 60

Optimization criterion 59

Optimization method
Description 46

Outlier
delete 95

P
p-Code version 119
Parameter optimization 26
Parameters 26
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4D cube 29
check 98
compressed model 29
correlation 61-62
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curve 28
edit 98
export 119
GroupAxis 30
lookup-table 27
map 27
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Quality

Evaluation 25

R
R^2 24
RMSE 24
Root Mean Square Error 24
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Scatter plot

select axes 94
Sensitivity
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Sequence

for optimization 60,119
in MOCA Runtime 119

Simulink model 99
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Toolbar 73
Tutorial 78
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data import 81
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models 99

U
User interface

Log window 76
main elements 73
navigation pane 75
toolbar 73

V
Variable See Function variable

W
Weight

data point 89
data set 90

Working steps
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models 99
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